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I 1 General Information

Read through this operating manual carefully before use and become familiar with the product.
Installation and start-up should not be carried out before reading and understanding this
document. Keep this manual readily available so that you can reference it as needed.

1.1 What Is the Purpose of this Operating Manual?

This manual serves as an aid for the installation and operation of the product and supports the
technical staff with all operating and maintenance tasks to be performed. Furthermore, this
manual is aimed at preventing dangers to life and health of the user and third parties.

1.2 Who Is this Operating Manual Targeted to?

The operating manual provides a code of conduct for personnel tasked with the setup,
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with
respect to the operation of gas engines and basic knowledge of electronic ignition systems are
necessary. Persons who are only authorized to operate the gas engine shall be trained by the
operating company and shall be expressly instructed concerning potential hazards.

1.3 Which Symbols Are Used in the Operating Manual?

The following symbols are used in this manual and must be observed:

Example

This symbol indicates examples, which point out necessary handling steps
and techniques. In addition, you receive additional information from the
examples, which will increase your knowledge.

EXAMPLE
& Notice
This symbol indicates important notices for the user. Follow these. In
addition, this symbol is used for overviews that give you a summary of the
ST necessary work steps.

Warning

This symbol indicates warnings for possible risks of property damage or
risks to health. Read these warning notices carefully and take the
mentioned precautionary measures.

8 Rev. 02/2020



I 1 General Information

DANGER

Danger

£ MOTORTECH

This symbol indicates warnings for danger to life, especially due to high
voltage. Read these warning notices carefully and take the mentioned

precautionary measures.

1.4 Which Abbreviations/Acronyms Are Used in the Operating Manual?
In the manual or the user interface, the following abbreviations / acronyms are used.

Abb.
ADV

ASO

ATDC

BTDC

CAN bus

CE

CPU

°crankshaft

CSA

Rev. 02/2020

Term Description

Advance Advanced with
respect to top dead
center

Auxiliary

Synchronization

Output

After Top Dead

Center

Before Top Dead
Center

Bus for control
devices / networks

Controller Area
Network bus

Conformité
Européenne

Conformity with EU
directives

Central Processing
Unit

Degree crankshaft

Canadian Standards
Association

Explanation

Indicates the direction for
timing

Output for synchronizing the
MIC4 and other controllers

Asynchronous serial
connection system for
linking control units

Mark based on EU
legislation for certain
products in conjunction with
product safety

Unit for the rotation angle of
the crankshaft

Organization that defines
standards, inspects
products for safety
compliance, and issues
pertinent certifications.



I 1 General Information

Abb. Term Description Explanation
DC Direct Current
DetCon Detonation Control Serves to prevent major
System engine damage that can be
caused by knocking
combustion.
EMI Electromagnetic
Interference
EMC Electromagnetic Compatibility of electrical or
Compatibility electronic equipment items
with their surroundings
GPI General purpose Multi-purpose input
input
GPO General purpose Multi-purpose
output output
HV High voltage
1SO International

Organization for
Standardization

LED Light Emitting Diode Light emitting electronic
semiconductor
MiC MOTORTECH Ignition
Controller
MICT MOTORTECH Software for the
Integrated configuration of the MIC4
Configuration Tool
MOSFET Metal Oxide Semiconductor component
Semiconductor
Field-Effect
Transistor
PG Panzergewinde Panzer Screw Screw thread type for cable
Thread screw connections
POT Potentiometer Continuously adjustable
potential divider
PWR Power Output / current
RET Retard Retarded with Indicates the direction for

respect to the top timing
dead center
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Abb. Term
RS485/ Recommended
TIA485 Standard 485/

Telecommunications
Industry Association

485
TDC Top Dead Center
USB Universal Serial Bus

Rev. 02/2020
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Explanation

Industrial standard for a
physical interface for
asynchronous serial data
transfer

Serial connection system to
link a computer to external
devices
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I 2 Safety Instructions

2.1 General Safety Instructions
The following safety instructions must be followed in the area in which the device is operated:

High voltage! Danger to life!

While the engine is running, the area around the ignition system especially
holds the risk of danger due to high voltage. The following parts should
therefore not be touched or removed unless explicitly stated otherwise:

DANGER

— Ignition coils and caps
— Wires of the high voltage circuit
— In- and output wiring of the ignition controller

— Pickups and their wiring

Danger to persons with pacemakers!

Electromagnetic impulses in the wiring of the ignition system may exceed
the permissible limits of pacemakers. Persons with pacemakers must
therefore not be present in the vicinity of the ignition system being
operated. Mark the operating location of the ignition system with the
corresponding standardized warning symbol.

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to
operate. Nevertheless the equipment can cause risks or damage can occur, if the following
instructions are not complied with:

- The gas engine must only be operated by trained and authorized personnel.

— Operate the equipment only within the parameters specified in the technical data.
— Use the equipment correctly and for its intended use only.

- Never apply force.

- Forall work such as installation, conversion, adaptation, maintenance, and repair, all
equipment must be disconnected from the mains and secured against unintentional
reactivation.

- Perform only such maintenance and repair work as is described in this operating manual,
and follow the instructions given while working.

— Only use spare parts supplied by MOTORTECH for the maintenance of the device.

—  Further work must only be performed by personnel authorized by MOTORTECH.
Non-compliance with the instructions will void any warranties for the proper function of the
equipment as well as the responsibility for the validity of the certifications.

- Safety devices must not be dismounted or disabled.

— Avoid all activities that can impair the function of the equipment.

12 Rev. 02/2020
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Operate the equipment only while it is in proper condition.
Investigate all changes detected while operating the gas engine or ignition system.

Ensure compliance with all laws, directives, and regulations applicable to the operation of
your system, including such not expressly stated herein.

If the system is not entirely tight and sealed, gas may escape and result in explosion hazard.
The inhalation of gas can also lead to death or severe health damages. Therefore, upon
completion of all assembly works, always check the system's tightness.

Always ensure adequate ventilation of the engine compartment.
Ensure a safe position at the gas engine.

There is a risk of burning on hot surfaces. Allow the engine to cool down before starting any
work.

Personal protective equipment (PPE), e.g. safety shoes and gloves, must be worn during all
work on the engine.

Your behavior can reduce possible residual risks to a minimum. Observe responsible
handling of the gas engine and the gas-carrying system.

2.2 Electrostatic Discharge Hazards

Electronic equipment is sensitive to static electricity. To protect these components from damage
caused by static electricity, special precautions must be taken to minimize or prevent
electrostatic discharge.

Observe these safety precautions while you work with the equipment or in its vicinity.

Before performing maintenance or repair work, ensure that the static electricity inherent to
your body is discharged.

Do not wear clothing made from synthetic materials to prevent static electricity from
building up. Your clothing should therefore be made of cotton or cotton mix materials.

Keep plastics such as vinyl and Styrofoam materials as far away from the control system, the
modules, and the work environment as possible.

Do not remove the circuit boards from the housing of the device.

Rev. 02/2020 13



I 2 Safety Instructions

2.3 Information on Electric Isolation
If ground and earth potential are not properly isolated, the following problems as well as others
can occur:

- Electromagnetic interferences (e.g. ground loops)

- Signal corruption (e.g. of the analog voltage signal)

— Unwanted leakage currents

Therefore, earth potential and the negative pole of the power supply of all devices in the electric
assembly that provide the option, should be connected separately. If possible, the negative pole

of the power supply should only be connected to earth potential at one point in the entire
system.

Wiring Example

Device with Device featuring
shielded wires protection class Il
=]

m
n

=

L+
24V DC
L-

1—
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Occurrence of ground loops

The devices shown in the following image do not feature the possibility to
connect the earth potential and the negative pole of the power supply
separated from each other. How ground loops are created.

A ground loop is a ground connection of an electric wiring assembly that is
closed as a loop. Due to impedance (resistance R » 0) of the loop,
low-frequency interference currents can lead to an unwanted voltage drop
in the signal path.

Device 1 Device 2

(@[
I !

Ground loop

2.4 Special Safety Instructions for the Device

DANGER

Rev. 02/2020

Danger to life! Hazardous residual voltage!

After stopping the ignition, there is dangerous residual voltage for up to
three minutes in the ignition system. Do not touch any components of the
ignition kit during this time.

Explosion hazard!

Never open the device (e.g. by removing covers or the service screw). If the
system is located in a hazardous area, there is a risk of explosion.

15



I 2 Safety Instructions

Explosion hazard!

The replacement of parts or assemblies can impair compliance with CSA
Class I, Division 2 (Group C, D), T4.

Explosion hazard!

Do not disconnect any connectors while the system is live. If the system is
located in a hazardous area, there is a risk of explosion.

Explosion hazard!

Never remove the equipment while the unit is connected to a power source.
If the system is located in a hazardous area, there is a risk of explosion.

Explosion hazard!

Do not remove or replace the fuse while the equipment is live.

Risk of burning!

The surfaces of the system may heat up to high temperatures.

16 Rev. 02/2020



I 2 Safety Instructions

Operational safety!

All connector screws and screw joints must be adequately tightened. Refer
to the section Mechanical Data on page 20.

After the service cover on the device (Light Duty and Heavy Duty Version)
has been opened, e.g. to complete the wiring, it must be refitted so that it is
in the same alignment as it was prior to opening. The USB connection is
then again behind the service screw. If the mounting is rotated, maintaining
the indicated protection classes, as well as compliance with CSA-Class I,
Division 2 (Group C, D) is impaired.

Operational safety

The correct operation of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply according to the specifications in the operating instructions.

Risk of destruction!

Magnetic fields and heat occur when welding, which may damage or
destroy the MIC4. Therefore, pay attention to the following when welding:

— Disconnect all electrical connections to the MIC4 prior to welding.

— Protect the MIC4 against direct contact with the welding unit and
magnetic fields, sparks and liquid metal.

2.5 Proper Disposal

After the expiration of its service life, MOTORTECH equipment can be disposed of with other
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally
friendly disposal.

Rev. 02/2020
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I 3Intended Use

3.1 Functional Description
The devices of the MIC4 series are microprocessor controlled ignition systems, that are
comprised of one 32 bit main processor (CPU) and an output board.

Please note that the manufacturer is not required to implement configurations of the ignition
controller for specific engines, and that devices may be delivered without pertinent
configuration.

The ignition controllers of the MIC4 series use information supplied by the pickups to precisely
determine the correct timing for the respective outputs. The timing is influenced by various
inputs made either automatically or manually. This can be implemented with manual
potentiometers, the analog input signals, a speed characteristic, or with a serial interface (USB,
CAN bus, RS485).

During operation, the ignition controllers continuously monitor the system status of all installed
pickups and the correct operation of the primary ignition circuit by checking the information
received.

Depending on the severity of an error that is detected, the device will shut down immediately or
warn the operator. A corresponding message can be viewed on a connected PC.

To protect the engine, the ignition controllers additionally have an adjustable overspeed
shut-off.

3.2 Applications

The ignition controllers of the MIC4 series are designed for specific 2- or 4-stroke gas engines.
From 1 to max. 16 ignition outputs are available. The ignition controllers supply the energy
required for the corresponding ignition coils of the gas engines and can supply signals for
peripheral equipment.

Any use other than the one described in the operating manual shall be considered improper use
and will result in the voiding of all warranties.
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MOTORTECH

4.1 Technical Data

4.1.1 Certifications
The ignition controllers of the MIC4 series are certified as per the following directives/
regulations:

CE

EMC Directive 2014/30/EU

EN 61326-1:2013 — Electrical equipment for measurement, control and laboratory use.
EMC requirements. General requirements

EN 55011:2009 + A1:2010 — Industrial, scientific and medical equipment.
Radio-frequency disturbance characteristics. Limits and methods of measurement

EN 61000-6-2:2005 + AC:2005 — Electromagnetic compatibility (EMC). Generic
standards. Immunity for industrial environments

EN 61000-6-4:2007 + A1:2011 — Electromagnetic compatibility (EMC). Generic standards.
Emission standard for industrial environments

Low Voltage Directive 2014/35/EU

EN 61010-1:2010 — Safety requirements for electrical equipment for measurement,
control, and laboratory use. General requirements

EN 60529:1991 + A1:2000 + A2:2013 — Degrees of protection provided by enclosures (IP
Code)

RoHS Directive 2011/65/EU

CSA Std C22.2 No. 0 -10
CSA Std C22.2 No. 142-M1987 (R 2004)
CSA Std C22.2 No. 213-M1987 (R 2004)

ANSI/ISA 12.12.01, Ed. 1 (2007)

UL Std No. 916, Ed. 3 (1998)

The Panel Mount Version fulfils the directives if it is installed in a correspondingly certified
control cabinet.
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1 4 Product Description

4.1.2 Mechanical Data
The MIC4 has the following mechanical characteristics.

Feature Value

Dimensions Panel Mount Version:
282.1mmx 202 mm x 66.6 mm (11.11" X 7.95" x 2.62")
(length x width x height)
Light Duty Version:
304 mm X 240 mm X 95.5 mm (11.97" X 9.45" x 3.76")
(length x width x height)
Heavy Duty Version:
304 MM X 240 mm X 115.5 mm (11.97" X 9.45" X 4.39")
(length x width x height)
Weight Panel Mount Version:
5.2 kg (11.5 lbs)
Light Duty Version:
3.9 kg (8.5 lbs)
Heavy Duty Version:
6.7 kg (14.8 lbs)
Shape of device See chapter Overview Drawings on page 28

Mechanical environmental  The housing is resistant to general atmospheric
conditions contaminations.
Resistant to gas engine lubricants.

Panel Mount Version:
Protection class: I, protection: IP20

Light Duty Version:
Protection class: |, protection: IP54

Heavy Duty Version:
Protection class: |, protection: IP65

The specified protection classes and types are only
guaranteed if all external wiring connections are made in
accordance with the connector specification, all covers and
seals are installed as intended and the following tightening
torques are observed:

— All Mg bolts: 0.8 Nm to 1 Nm (0.6 lb-ft to 0.7 lb-ft)
- PG screw joints: 4.5 Nm to 5 Nm (3.3 lb-ft to 3.6 lb-ft)
- Service screw: 2.5 Nm to 3 Nm (1.9 lb-ft to 2.2 lb-ft)

Always use a new seal when installing the service cover.

20 Rev. 02/2020



1 4 Product Description = MOTORTECH

Feature Value

Standard single seal inserts Suitable for a cable with a diameter of 6 mm to 13 mm.
for PG screw joints (Heavy

Duty and Light Duty

Version)

Multiple seal inserts for PG Suitable for up to three cables, each with a diameter of 6 mm
screw joints (Heavy Duty toz7 mm.
and Light Duty Version)

Climatic environmental Panel Mount Version:
conditions —-20 °C to +50 °C (-4 °F to +122 °F)
Light Duty Version:

—40 °C to +60 °C (40 °F to +140 °F)

Heavy Duty Version*:

-40 °C to +70 °C (40 °F to +158 °F)

Max. 85 % humidity without condensation up to 2,000 m
(6,561.68') above sea level

Determining Maximum Ambient Temperature for Heavy Duty Version
* The maximum ambient temperature for the Heavy Duty Version of the MIC4 is dependent on the
net power delivered. This can be up to +80 °C (+176 °F) for low net power.

Net power Max. ambient temperature
18 W +80 °C (+176 °F)
36 W +75 °C (+167 °F)
54 W +70 °C (+158 °F)

Determine the maximum ambient temperature for the Heavy Duty Version of the MIC4 as follows:

1. Determine the net power (P) delivered.

Engine type Max. ambient temperature

Two-Stroke Engine

p= Number of Revolutions [min™"] x Energy [J] x Number of Ignition Outputs
: 60

Four-Stroke Engine

pe Number of Revolutions [min”] x Energy [J] « Number of Ignition Outputs
h 60 2

Rev. 02/2020 21



1 4 Product Description

Notice:

Energy refers to the set energy limit (see Timing — Schedule A/B — Energy on page 107). The
number of outputs refers to the configured outputs.

2. Calculate the maximum ambient temperature.

Max. ambient temperature in°C=80 - (P - 18) x 5 /18
The formula is defined for P > 18 W. The ambient temperature is therefore limited to

+80 °C (+176 °F).

4.1.3 Warning Notices on the Device

Warning notice on the device

WARNING! Read and
understand the installation
and operating manual prior to
installing or making any
adjustments.

EXPLOSION HAZARD! Do not
disconnect while circuit is
live unless area is known to
be non-hazardous. For wiring
details refer to the operating
manual.

CAUTION! Do not pressure
wash this ignition module.
Damage to electronic
components may result.

22

Validity of warning notices on device

German translation

WARNUNG! Lesen und
verstehen Sie die Instal-
lations- und Betriebs-
anleitung vor der Installation
und bevor Einstellungen
vorgenommen werden.

EXPLOSIONSGEFAHR! Keine
Verbindungen lésen, solange
der Stromkreis aktiv ist,
aufer das Umfeld wird als
nicht explosionsgefahrdet
eingestuft. Hinweise zur
Verkabelung finden Sie in der
Betriebsanleitung

ACHTUNG! Die Ziindsteue-
rungseinheit nicht mit Hoch-
druck reinigen. Es konnte zu
Schaden an den elektro-
nischen Bauteilen fiihren.

The warning notices on the device are valid for the MIC4 and all
components connected to it.

French translation

ATTENTION! Avant d’installer
ou d’effectuer une
modification, lisez et
comprenez le manuel
d’utilisation et d’installation.

RISQUE D‘EXPLOSION! Ne
débranchez pas lorsque le
circuit est sous tension sauf
si la zone est connue pour
étre non dangereuse. Pour
plus de détails de cablage,
veuillez consulter le manuel
d’utilisation.

ATTENTION ! Ne pas laver
cette boite de contrdle en
utilisant un jet sous pression.
Les composants électriques
peuvent étre endommagés.
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I 4 Product Description

4.1.4 Product Identification — Labeling on the Device
The necessary numbers for unique product identification are on the device:

—  Product number of the ignition controller (P/N)
— Arrangement number of the ignition controller (A/N)

— Serial number of the ignition controller (S/N)

MOTORTECH

www.motortech.de

| P/N  66.00.410-16 |

c E |A/N_ 422.16.C000-000-AA-0 |

|SIN 01008066 |

4.1.5 Electrical Data
The MIC4 has the following electrical characteristics.

Feature Value

Power consumption max. 100 W at 24 V

Power supply Nominal voltage: 24 V DC
Operating voltage: 10 VDCto 32 V DC

Required current Max. current 7 A. An estimation of the power requirements can be
found after this table.

Number of outputs 8 outputs

Firing Angles The size of the firing angle depends on the max. overspeed. The

smallest firing angle per output bank can be calculated using the
following formula:

0 d [min!
Ignition Angle = %[mm] x360° x 1.7 ms

Rev. 02/2020
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1 4 Product Description

Feature Value

Ignition frequency With full energy output (all 16 ignition outputs with 300 mJ), an
ignition frequency of 250 Hz as continuous load is possible. With
less ignition energy or in case of a brief overload, 333 Hz is
possible. The maximum output load of 75 W must not be
exceeded.

2-stroke engine:

Overspeed [min™']

Ignition Frequency = x Number of Ignition Outputs

4-stroke engine:

1, Overspeed [min™']

Ignition Frequency = 2 %0 x Number of Ignition Outputs

Output connector 17-pole military connector

Estimation of Current Requirements
These current values are based on a nominal speed of 1800 rpm and 300 m) energy.

Outputs Voltage Required current  Voltage Required current
8 24V 2.3A 12 V** 4.6 A

12 24V 3.3A 12V ** 6.4 A

16 24V 4.3A 12 V ** 6.8A*

* Ignition energy is limited to 250 m).
** Nominal voltage 24 V DC
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MOTORTECH

Electrical Data for Inputs and Outputs
The inputs and outputs of the ignition controller have the following electrical data:

Inputs and outputs

Analog current input

Analog voltage input

Auxiliary analog input
supply voltage

Binary input (Start/Stop)

Binary input (schedule A/B)

Binary input (GPI, general
purpose input)

Go/NoGo and GPO outputs

Rev. 02/2020

Values

Current range: o mA to 20 mA (adjustable in MICT)
Inputimpedance: 27 Q || 1 pF

Voltage range: o mA to 10 mA (adjustable in MICT)
Input impedance: 12.4 kQ || 200 nF

5V to 24V /50 mA depending on the configuration in the
MICT

Wiring
Input current: max. 20 mA

Ignition stop: o V to 0.8 V (low level)
Ignition release: 2.8 V to 32 V (high level)

Wiring
Input current: max. 20 mA

Schedule A: 0 V to 0.8 V (low level)
Schedule B: 2.8 V to 32 V (high level)

Wiring
Input current: max. 20 mA

Low level: 0 Vt0 0.8V
High level: 2.8 Vto 32V

(Function dependent on the configuration in MICT, see
Inputs/Outputs — Inputs on page 114)

One GPO (General Purpose Output) and one Go/NoGo output
Implementation as optical MOSFET relay

Maximum switching voltage: 32 V DC

Peak/steady current: max. 100 mA DC

Output power: max. 2.5 W

Internal resistance: 58 Q to 60 Q

Activation delay: 0.5 ms/100 mA load max.

Deactivation delay: 0.2 ms / max. 100 mA load

If a short is found at the output, a safety circuit, which makes
the output highly resistive, is found at the output, so that the
current sets itself at 50 mA to 60 mA.
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1 4 Product Description

Inputs and outputs Values
Signal LED Six LEDs are used as status indicators.
ASO output TTL level (5 V)

max. current: £ 10 mA
Pickup input Impedance: 10 kQ

The voltage supply for active pickup can be set using the
MICT from 5 Vto 24 V.

Max. frequency for the pickups: 10 kHz

The formula for determining the frequency of the pickups can
be found in the note following this table.

For a pickup output impedance of 120 Q to 10 kQ, the pickups
connected to the MIC4 may not have a higher voltage than
+40 V and the connected power may not exceed 1 W.

Ignition coil outputs Output voltage: max. 250 V

Output energy in normal operation: max. 300 mj (depending
on the ignition coils used)

Output energy in the start phase (boost): max. 500 m)

& Frequency of the pickups
. The frequency of the pickup is calculated as per the following formula.

in-1
NOTICE Frequency = W x Number of Pickup Events per Revolution
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I 4 Product Description

4.1.6 Interfaces
Depending on the device version, the following interfaces are available:

USB Interface
- Compatible with USB 2.0

— The Connector B version is only suitable for temporary data exchange and not for a
permanent connection.

- Max. wire length 5 m (16.4")

CAN Bus Interface
— Classical Extended Frame Format (CAN 2.0B)

— AsperISO 11898 standard, 50 kbit/s to 1 Mbit/s
- Transient-proof (automotive classification)
- Max. 110 participants

- Max. wire length 250 m (820') depending on the transfer rate

RS485 Interface
- According to TIA-485-A (03/2003)

- Max. 32 participants
- Max. data transfer rate 9.6 kbit/s to 115.2 kbit/s

- Max. wire length 100 m (328') depending on the transfer rate

) Pay attention to the wiring diagrams
Depending on the device version, certain signals or interfaces described in
these instructions may not be available. You are also always to pay

attention to the wiring diagrams enclosed with the input and output cable

NOTICE
harnesses.

4.1.7 Requirements for External Equipment
External equipment shall fulfill the input and output specifications of the MIC4.

Rev. 02/2020
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1 4 Product Description

4.1.8 Overview Drawings

Panel Mount Version
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Light Duty Version
The connectors shown correspond to the standard version.
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1 4 Product Description

Heavy Duty Version
The connectors shown correspond to the standard version.
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I 4 Product Description

4.1.9 LEDs and Connections
LEDs on the MIC4

O Status
O Firing
(O Pickup 1
(O Pickup 2
(O Pickup 3
O GpPO
I
Status LED flashes green when the device is running with no errors. If an error
occurs, the LED is red, for a warning it is yellow.
Firing LED lights up when the ignition is active (exception: during the self test).
Pickup 1to 3 Flashing LEDs indicate activity of the pickups.
GPO LED is on when the GPO is activated.

Connections and Functions under the Service Cover

123 456 1234567 8910M1N1

Rev. 02/2020
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1 4 Product Description

Labeling

Power

UsB
PB

M31IS 3IIAIBS

ayj Japun suonouny
pUE SUOI1I8UUO)

A/B

Pickup

CAN

Binary Output

RS485

Analog/Binary Input

Function

Connection for the supply voltage (see Input Wiring — Power
Supply on page 38)

USB connection for connecting to the PC

Button acknowledges errors, warnings and alarms or triggers a

reset of the ignition controller. Please refer also to the notice
below.

Potentiometer for the manual adjustment of the ignition timing.
The setting only has an effect if the potentiometer in the MICT is
activated.

Connection for the pickups (see Input Wiring — Pickups on

page 40)

CAN interface for connecting external equipment (see Output
Wiring — CAN Bus Interface on page 50)

Connection for binary outputs (refer to Output Wiring — Binary
Outputs (Go/NoGo, GPO, ASO) on page 46)

RS48s5 interface for connecting external equipment (see Output
Wiring — RS48s5 Interface on page 52)

Connection for timing & safety devices (see Input Wiring — Timing
and Safety Devices on page 43)

& Behavior of the button PB

. With the PB button on the device you can perform the following actions:

32

Press briefly (< 3 s):
Existing warnings are acknowledged.

Press longer than 3 s:

If no pickup signals are detected and an operating error exists, this will
be acknowledged together with all alarms. Warnings are acknowledged
in any case, even if no operating error exists.

Press longer than 15 s:
If no pickup signals are detected, the ignition controller restarts.
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I 5 Installation Instructions £ MOTORTECH

5.1 Unpacking

Unpack the equipment, taking care not to damage it. Always place the device safely and
protected from falling over or falling down. Ensure that the operating manual is always stored
with the ignition controller and is easily accessible. Check the contents for completeness and
verify that the device type meets your application requirements.

Scope of Supply
The scope of supply of the MIC4 ignition controller consists of the following components:

— Ignition controller of the MIC4 series

- Installation set incl. four vibration dampers

- Ground strap

— Three multiple sealing inserts and five sealing plugs for PG screw joints

- Storage device (USB flash drive or CD-ROM) with software for configuring the ignition
controller

- USB interface cable for connecting the ignition controller to a PC/laptop

— Operating manual

5.2 Installation of the Ignition Controller

The installation of the MIC4 ignition controller is implemented on a fixed bracket, e. g. on a wall
near the engine, for the Light Duty or Heavy Duty Version. Install the Panel Mount Version in a
suitable control cabinet. Use the included rubber vibration dampers and the ground strap for all
three versions. The installation location of the controller must be selected so that the distance to
the pickups installed on the engine ensures a reliable signal transmission to the ignition
controller, and so that there is adequate space for maintenance and repair work. The mechanical
specifications must always be complied with (refer to Mechanical Data on page 20). The ground
strap serves to ground the ignition controller and must be used accordingly. Ensure a flawless
electrical connection for this purpose.

Installation locations where strong vibrations or extreme ambient temperatures are present are
not permissible and result in the warranty being voided. The permissible temperature ranges
are:
- Panel Mount Version: —20 °C (-4 °F) to +50 °C (+122 °F)
- Light Duty Version: —40 °C (=40 °F) to +60 °C (+140 °F)
- Heavy Duty Version: —40 °C (40 °F) to +70 °C (+158 °F)

To ensure sufficient cooling through the cooling body, the Heavy Duty Version must be

mounted so that the vanes of the cooling body are vertical and the hot air can escape
upwards unimpeded.
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Risk of destruction!

The device must not be installed directly on or at the engine, as vibration
and heat may cause damage to electronic components. This also applies if
vibration dampers are used.

5.2.1 Installation of the Vibration Dampers
There are two options for using the vibration dampers from the MIC4's scope of supply. The hole
patterns can be found in section Overview Drawings on page 28.

Option A

screws M8x16 B, four rim lock washers
M8 and four washers Mg 1.

2. Fasten the MIC4 to the vibration dampers.
Use four washers M8 and four lock nuts
vs H.
» Fasten the ground strap to the ground
pin (see Installation of the Ground
Strap on page 35).

1. Fasten the four vibration dampers Bl to the
@ R 27 Nm /19 Ib-ft selected installation location. Use four
|

.

]~

Bo i

PA 27 Nm / 19 Ib-ft
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Option B

22 27 Nm / 19 Ib-ft |
- H
== A

\il\
|

= [

rel 5 PEGYREIE

5.2.2 Installation of the Ground Strap

=}
3 o
$
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Fasten the four vibration dampers B8 to
the MIC4. Use four screws M8x16 , four
rim lock washers M8 and four washers
ms .

Fasten the MIC4 to the selected installation

location using the vibration dampers. Use

four washers M8 and four lock nuts

ms H.

» Fasten the ground strap to the ground
pin (see Installation of the Ground
Strap on page 35).

Fasten the ground strap to the MIC4
ground pin. To do so, use one washer
M6 , one tooth lock washer A6 and
one poly lock nut M6 A

Connect the ground strap to one of the
sides suitable for grounding.

> You can wire the ignition controller as
described in section Wiring of the
Device on page 37.
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5.3 Determine the Installation Location of the Pickup
Set the positions of the pickups depending on engine type and application. All angle reference
information is based on:

TDC 1st cylinder / compression cycle

The installation location for the pickups must have adequate mechanical strength and must not
exceed the specified temperature ranges. The pickups are designed for the appropriate use
only, multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate
the calibration of the sensor. Comply with the pertinent regulations for the wire routing.

For the exact positioning of the individual pickups, refer to the examples given in the drawings
(see section Input Wiring — Pickups on page 40).
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I 6 Wiring of the Device

6.1 Input and Output Wiring on the Controller

Rev. 02/2020

Operational safety!

All connector screws and screw joints must be adequately tightened. Refer
to the section Mechanical Data on page 20.

After the service cover on the device (Light Duty and Heavy Duty Version)
has been opened, e.g. to complete the wiring, it must be refitted so that it is
in the same alignment as it was prior to opening. The USB connection is
then again behind the service screw. If the mounting is rotated, maintaining
the indicated protection classes, as well as compliance with CSA-Class I,
Division 2 (Group C, D) is impaired.

Operational safety!

Improper wiring using the PG screw joints impairs the compliance with the
specified protection classes as well as with CSA Class I, Division 2 (Group C,
D). Please adhere to the following points:

— Do not pass any cables without matching sealing inserts through the PG
screw joints.

— Asealing insert must be used in every PG screw joint.

— Unused bore holes for the sealing inserts must be sealed using sealing
plugs.
— The PG screw joints must be adequately tightened.

For additional information on PG screw joints and sealing inserts please
refer to Mechanical Data on page 20.

Assignment of the wire colors

Take the assignment of the wire colors of the wiring harness for the input
and output wiring from the wiring diagram enclosed with the wiring
harness.

Pay attention to the wiring diagrams

Depending on the device version, certain signals or interfaces described in
these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
harnesses.

MOTORTECH
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I 6 Wiring of the Device

6.1.1 Input Wiring — Power Supply

Operational safety

The correct operation of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply according to the specifications in the operating instructions.

& Design of power supply
For the power supply, an overcurrent protection mechanism must be set up
with a circuit breaker (16 A DC with tripping characteristic B), which allows

switching off. When selecting the circuit breaker, the conditions of the
installation site and the ambient temperature must be considered. The
circuit breaker must be easy for the user to access and marked as a
disconnecting device for the ignition controller.

NOTICE

If the power is supplied via a power supply unit, the following specifications
must be observed additionally:

— Voltage: 24 V DC; Current: at least 25 A

—  Wiring: at least 1.5 mmz2 cross-section
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L 2 24V DC (nominal voltage)

Variations

1 Battery Generator Control unit
2 Power supply
— |-
—o L+ + —o
~v
(LD ? 3 Battery Charger
- L+

v

Rev. 02/2020
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I 6 Wiring of the Device

6.1.2 Input Wiring — Pickups

Example Configuration (one Active, two Passive Pickups)

~ F Camshaft
A

Crankshaft
(Reset)

\ /

Crankshaft

(9 G

0O 3 5 ®

s 225
o .=
w o

Power

Pwaer 6
@ IV
©)
Signal @
(=)
()
&)

T O
8
2

Shield

o

Pickup 1 Pickup 2 Pickup 3

The recommended distance to the triggering is 0.75 mm to 1 mm (0.03" to 0.04") for MOTORTECH
pickups. Please note that additional fine-tuning is required for every pickup position due to the
different conditions of the engines.
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One revolution of the pickup changes the distance as follows:

M12x1 1 revolution 2 1 mm (0.04")
5/8"-18 UNF 1 revolution 2 1.41 mm (0.05")
3/4"-16 UNF 1 revolution 2 1.59 mm (0.06")

Allocation of the Wire Colors (Example Configuration)

Camshaft
PIN Designation Wire color
1 Pickup 1 Power Brown
2 Pickup 1 Signal black
3 Pickup 1 GND blue
4 Pickup 1 Shield Shield
Crankshaft (Reset)
PIN Designation Wire color
6 Pickup 2 Signal Flywheel with pin Flywheel with hole
White Brown
7 Pickup 2 GND Flywheel with pin Flywheel with hole
Brown White
8 Pickup 2 Shield Shield
Crankshaft
PIN Designation Wire color
10 Pickup 3 Signal White
11 Pickup 3 GND Brown
12 Pickup 3 Shield Shield

For problems with the pickup signals, refer to the section Pickup Input Errors on page 168.
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42

NOTICE

Adjusting the pickup sensitivity

Depending on the type of impulse source (interference), it may be necessary
to increase the pickup sensitivity to ensure that the resultant signal
strength is sufficient for reliable operation. You can make these
adjustments in the MICT. Refer to the section Engine — Pickups on page 99.

Aux. pickup supply voltage

An auxiliary supply voltage for active pickups can be configured using the
MICT. The voltage can be set in the range from 5V to 24 V and is supplied at
the connections Pickup 1 Power to Pickup 3 Power. Refer to the section
Engine — Pickups on page 99.
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6.1.3 Input Wiring — Timing and Safety Devices

The input wiring of the timing and safety equipment is dependent upon the hardware version of
the ignition controller. These are found in the MICT in the view Runtime Data — Information (refer
to section Runtime Data — Information on page 146).

Wiring Hardware Version 1.3.x/1.4.x (Example Configuration)

—{:} *) See subsequent drawings for details

x = bridge for permanent authorization
(must be removed for external ignition
authorization)

_— Switch Start/Stop
*>—1q
open Ignition — OFF
—0/0—1
closed Ignition — ON

9 Switch A/B
open Schedule A
closed Schedule B

Timing U in + é
Analog GND @
Analog Power @
Timing Iin - @
Timing Iin + @
Analog Shield @
Start/Stop + @
Schedule A8 + |(==)
GPI1 + @
L———  Binary Com @
Binary Shield ®—
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Wiring Hardware Version 1.2.x (Example Configuration)

N

|

T d

*) See subsequent drawings for details

x = bridge for permanent authorization
(must be removed for external ignition
authorization)

Switch Start/Stop
open Ignition — OFF

closed Ignition — ON

Switch A/B
] open Schedule A
1)(2)(3)(4)(5 7)(8)(9 11
OOOOEOEO®OOEM closed Schedule B
: 2 8 L £33 a B a3 2
= O - = = o [&] = o
2gspeps2gs2bd
€ &8 § E E R & £ g &S
SR -
I
X
X
Two-Wire Transmitter Four-Wire Transmitter

Analog Power

N

Analog Power

Timing l'in +

—

Timing | in -

------ Analog GND

+1 Timing l'in +

-1 Timing l'in -
-V L Analog Shield

Analog Shield
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I 6 Wiring of the Device

EXAMPLE

Rev. 02/2020

MOTORTECH

Auxiliary analog input supply voltage

An auxiliary supply voltage for the analog inputs can be configured using
the MICT. The voltage can be set in the range of 5 to 24 V and is made
available on the connection Analog Power. Please refer to the section
Timing — Analog Inputs on page 103.

Wiring MIC4 ignition controller and DetCon detonation control system

The following diagram shows an example of the wiring of a MIC4 ignition
controller with a DetCon detonation control system in cases where the
analog current signal (4-20 mA) at the output / out is to be used for the
ignition timing adjustment.

.
+ 5] k-] o -
s 2 3 Lt 2+ < e 3
> O o = = & g _% 38 =
> 2 9 o o @ B B +
E & & £ £ 2 3 X =z =2
E = 8 EE &5 £ 5 & € MIC4
e S e S R R ignition
IOOOOOOOE®E®@|  controller

-
i

control system

Com O
O

Trip O
O

Com O

Engine

DetCon
O O O| detonation
=
()
L

| out +
| out—

@

- 1O
2ee O
Uout + O

Reduction
Knocking

Load

Furthermore, the limits of the analog current input will need to be set at
4 mA to 20 mA and the auxiliary supply voltage of the analog inputs to 24 V
in the MICT. Please refer to the section Timing — Analog Inputs on page 103.

The timing is transmitted by MIC4 via the auxiliary synchronization output
(ASO) to the DetCon, and will need to be wired and configured accordingly.
Please refer to the section Output Wiring — Binary Outputs (Go/NoGo, GPO,
ASO) on page 46.
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I 6 Wiring of the Device

) General purpose input GPI

The general purpose input GPI can be assigned various functions via the
configuration. Refer to the section Inputs/Outputs — Inputs on page 114.

NOTICE

6.1.4 Output Wiring — Binary Outputs (Go/NoGo, GPO, ASO)

Example Configuration
oL+

[ -
*) DetCon or other external device (for wiring
I:KZ:I—-- of the DetCon, see following example)
K1 =Go/NoGo relay
K2 = GPO relay
L27VDCto32VDC

ol-

|\

Go/NoGo + 6
GolNoGo - [(~)
PO+ |(«)
ePo- |(=)
As0+ (=)
Aso- |(=)
shield |(~)
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I 6 Wiring of the Device

o + o+
l Out +
A1 | 9 Out -
$ E | _ﬁ Relay AM |
- 5
51 Relay
o Qut+ A2
T Out-
o — o —

(L27VvVDCto32VDQ)

DetCon connection

Connect the ASO output on the DetCon to the connections in A and in B on
connector Synchronization.

EXAMPLE
DetCon
Synchronization
<C o
£ £

|\

Go/NoGo + 6
Go/NoGo - @
PO+ (=)
ePo- ()
Aso+ |()
AsO- [(=)
shield [(<)
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I 6 Wiring of the Device

6.1.5 Wiring — PowerView3s

Connect the PowerView3 visualization unit to the MIC4 as follows.

CAN Connection between Ignition Controller and PowerView3

As shown in the following illustration, you can connect the PowerViews3 directly to the
MOTORTECH ignition controller using the CAN cable delivered with the PowerViews. To do so,
you need to insert the connector in the CAN interface on the PowerView3s. On the ignition
controller, connect the color-coded conductors of the CAN cable to the correct CAN interface

connections.

z| - Connector for CAN
5le 5 £ & 8 interface on PowerViews
L] [
D
O
CAN interface on the

|® @ @ @ @ @ @ | ignition controller
£33
=2z 5
120 Q

PowerViews Power Supply via the Ignition Controller

If you use a MOTORTECH ignition controller with a service cover and connector strip, you have
the option of supplying power to the PowerViews3 via the ignition controller. A special connector
is included in the PowerView3's scope of supply. The connector for the voltage supply of the
ignition controller must be replaced by this one.
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I 6 Wiring of the Device

MOTORTECH

Connector supplied with Connector supplied with
the ignition controller: PowerViews:

Proceed as follows:

1.

2.

3.

Disconnect the power supply to the ignition controller and, if necessary, to the PowerViews.
Remove the connector for the power supply from the ignition controller.

Negative terminal: Disconnect the conductor from the contact and insert it into
contact 8 of the connector provided with the PowerViews.

Positive terminal: Disconnect the conductor from the contact and insert it into contact
of the connector provided with the PowerViews.

From the PowerView3 power supply cable, plug the L— wire (white) into contact B, ror
plugging into the contact, use a wire end ferrule provided with the PowerViews.

From the PowerView3 power supply cable, plug the L+ wire (brown) into contact B For
plugging into the contact, use a wire end ferrule provided with the PowerViews.

Insert the connector provided with the PowerView3 into the power supply connection of the
ignition controller.

Insert the connector at the other end of the PowerView3 power supply cable into the
PowerView3 power supply connection.

Connect the device's power supply.

> The power supply of the PowerView3s is now provided through the connector on the
ignition controller.
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I 6 Wiring of the Device

6.1.6 Output Wiring — CAN Bus Interface
The product must be connected to a CAN bus as follows:

First device Second-to-last device
£ £ 3z 5 E =
£ 38 3 £8 3
CAN Bus
e £ 3 i // i
£ 8§ § |R120Q \\ R=120 Q

DOOOOEOE
S Z S =z
3
Second device Last device

Notice: The CAN-Bus connectors 1-4 are currently unavailable.

& CANopen® protocol

If you require information on the CANopen® protocol, contact your
MOTORTECH contact person.

NOTICE
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I 6 Wiring of the Device = MOTORTECH

CAN bus wiring
Note the following when connecting the CAN bus:

- Each bus end must be fitted with a terminating resistor of 120 Q (see
drawing).

- The maximum wire length depends on the bit rate:

Bit rate Maximum wire  Maximum length Maximum length of
length of a stub all stubs

1 Mbit/s 25 m (82" 1.5m (5 7.5 m (25"
800 kbit/s 5o m (164" 2.5m (8" 12.5m (41"
500 kbit/s 100 m (328') 5.5 m (18") 27.5 m (90')
250 kbit/s 250 m (820" 11m (36') 55 m (180')
125 kbit/s 500 m (1,640) 22 m(72') 110 m (360")
50 kbit/s 1,000 m (3,280") 55 m (180" 275 m (902"

— Only use cables that are specified by the manufacturer for use in the
CAN bus.
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I 6 Wiring of the Device

6.1.7 Output Wiring — RS485 Interface

The RS48¢ interface can be wired as two-wire or four-wire wiring and twisted cables must be
used. With both variants the load resistance (Rr=120 Q) is the characteristic impedance of the
cable.

Two-Wire Wiring

First device Last device
RX + RX +
RX - RX -
TX - TX -
X+ TX +
Second device Second-to-last device
Four-Wire Wiring
First device Last device
(Master) (Slave)
RX+ /A X +
iR ( iR
RX- T™X-

- A\ RX -
i ) i
X+ ' - /— RX +

+ I | + + 1 | +

2 BE B 2 BE B
Second device Second-to-last device
(Slave) (Slave)
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I 6 Wiring of the Device = MOTORTECH

Connection on the Ignition Controller

RS485
+ 1 g + 1
FESEE

A

i

+ | £ + 1 =]
= X8z 52
8 888y ”
d D DI
X o g o
& Wiring of the RS485 interface
. Follow these instructions for the RS485 interface wiring:
— Max. 32 devices can be connected to a bus.

NIOIEICE The maximum wire length is 100 m (328') depending on the transfer

rate.

— Each bus end must be fitted with a terminating resistor with 120 Q in
each pair of leads (as indicated in the drawing).
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I 6 Wiring of the Device

6.2 Ignition Coil Wiring

54

NOTICE

Protection when using wiring rails

Every wiring rail on the engine block should be grounded to avoid
disruptions in the device caused by secondary current in the ignition coils.

Ignition coil wiring

In the MICT there are two types of wiring with predefined output
configuration supported in the engine database for many engines:

— Wired in straight order

— Wired in firing order

For information on straight order wiring refer to Straight Order Wiring of the
Ignition Outputs on page 57 and Engine — Parameters on page 91.

For wiring in firing order, the first cylinder in the firing order is connected to
the A1 output, the second to B1 (A2 for one output board), etc.

If a different wiring was implemented, the output configuration in the MICT
must be adapted accordingly. Please note that the wiring cannot be
checked by the software (see section Engine — Parameters on page 91).

Conductor cross-section for primary wiring

If you do not use a harness manufactured by MOTORTECH, the primary
wiring must have a conductor cross-section of 1.5 mm2.
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I 6 Wiring of the Device = MOTORTECH

6.2.1 17-Pole Connector — Standard
The table contains the pole assignment for the Light Duty and Heavy Duty MIC4 for 8 and 16
cylinders.

(View: 17-pole connector from the outside)

m 16 outputs 8 outputs |

A Output A1 Output A1

B Output B1 Output A2

C Output A2 Output A3

D Output B2 Output A4

E Output A3 Output Ag

F Output B3 Output A6

G Output A4 Output A7

H Output B4 Output A8

J Output Asg Not assigned
K Output Bg Not assigned
L Output A6 Not assigned
M Output B6 Not assigned
N Output A7 Not assigned
P Output By Not assigned
R Output A8 Not assigned
S Output B8 Not assigned
T Ground Ground
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I 6 Wiring of the Device

6.2.2 10- and 9-Pole Connectors (Panel Mount Version)
The tables show the pole assignments for the Panel Mount Version with a 10-pole and a 9-pole
connector:

Connector A Connector B

OOOOOOOOO®M]| [DOOOOOOOE)]

Pin Assignment Connector A

Pole 16 Outputs / 8 Outputs
1 Output A1

2 Output A2

3 Output A3
4 Output A4
5 Output Ag
6 Output A6
7

8

9

Output A7
Output A8
Ground

10 Ground

Pole Assignment Connector B (not Available for 8 Outputs)

Pole 16 outputs

1 Output B1
2 Output B2
3 Output B3
4 Output B4
5 Output Bs
6 Output B6
7 Output B7
8 Output B8
9

Ground

56 Rev. 02/2020



I 6 Wiring of the Device = MOTORTECH

6.3 Straight Order Wiring of the Ignition Outputs

Risk of damage to engine

If you use straight order wiring, it is absolutely necessary that the
MOTORTECH wiring rail for the respective engine is used and correctly
installed. Even a rotated installation can cause serious damage to the
engine, for example.

Straight order wiring, along with wiring in firing order, is supported by the MICT for many
engines with predefined output configurations in the engine database. That means that if the
wiring is carried out accordingly and the option wired in straight order (user defined orientation)
is selected in the MICT, no other adaptation of the output configuration is necessary.

You can use straight order wiring, if:

- Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the
wiring rail are identified with Connector Pin 1 to Connector Pin X.

- Make the wiring of the ignition controller corresponding to the instructions in the following
sections (for example with an open wiring harness or via a junction box).
Execution of straight order wiring is dependent on the following factors:

— Output connector on the ignition controller (17-pole connector [Light Duty/Heavy Duty
Version], 10-pole/9-pole connector [Panel Mount Version])

— One ortwo output banks in the ignition controller (8 or 16 outputs)
- Type of engine (in-line or V-engine)

— Alignment of the wiring rail(s)
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I 6 Wiring of the Device

6.3.1 Straight Order Wiring for the Panel Mount Version

Panel Mount Version with 8 Outputs (One Output Bank)
Connector A

[ole)elolelolelolol0)

Wiring Connector A (Connector B not used with 8 outputs)

Pole 8 outputs In-line engine V-engine
(one output bank)
Connector* Coil** Connector*

1 Output A1 1 1 1 1
2 Output A2 1 2 2 1
3 Output A3 1 3 1 2
4 Output A4 1 4 2 2
5 Output Asg 1 5 1 3
6 Output A6 1 6 2 3
7 Output A7 1 7 1 4
8 Output A8 1 8 2 4
9 Ground

10 Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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I 6 Wiring of the Device = MOTORTECH

Panel Mount Version with 16 Outputs (Two Output Banks)
Connector A Connector B

OOOOOOOOO®M]| [DOOOOOOOE)]

Wiring Connector A

Pole 16 outputs In-line engine V-engine
(two output banks)
Connector*  Coil** Connector*  Coil**

1 Output A1 1 1 1 1
2 Output A2 1 3 1 2
3 Output A3 1 5 1 3
4 Output A4 1 7 1 4
5 Output As 1 9 1 5
6 Output A6 1 11 1 6
7 Output A7 1 13 1 7
8 Output A8 1 15 1 8
9 Ground

10 Ground

Wiring Connector B

Pole 16 outputs In-line engine V-engine
(two output banks)
Connector*  Coil** Connector*  Coil**

1 Output B1 1 2 2 1
2 Output B2 1 4 2 2
3 Output B3 1 6 2 3
4 Output B4 1 8 2 4
5 Output Bg 1 10 2 5
6 Output B6 1 12 2 6
7 Output B7 1 14 2 7
8 Output B8 1 16 2 8
9 Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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6.3.2 Straight Order Wiring for Light Duty and Heavy Duty Version
Light Duty and Heavy Duty Version with 8 Outputs (One Output Bank)

(View: 17-pole connector from the outside)

8 outputs In-line engine V-engine
(one output bank)
Connector*  Coil** Connector*  Coil**

A Output A1 1 1 1 1
B Output A2 1 2 2 1
C Output A3 1 3 1 2
D Output A4 1 4 2 2
E Output Asg 1 5 1 3
F Output A6 1 6 2 3
G Output A7 1 7 1 4
H Output A8 1 8 2 4
J =

K -

L =

M -

N =

P -

R -

S -

T Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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Light Duty and Heavy Duty Version with 16 Outputs (Two Output Banks)

(View: 17-pole connector from the outside)

Pole 16 outputs In-line engine V-engine
(two output banks)
Connector*  Coil** Connector*  Coil**

A Output A1 1 1 1 1
B Output B1 1 2 2 1
C Output A2 1 3 1 2
D Output B2 1 4 2 2
E Output A3 1 5 1 3
F Output B3 1 6 2 3
G Output A4 1 7 1 4
H Output B4 1 8 2 4
J Output Ag 1 9 1 5
K Output Bs 1 10 2 5
L Output A6 1 11 1 6
M Output B6 1 12 2 6
N Output A7 1 13 1 7
P Output By 1 14 2 7
R Output A8 1 15 1 8
S Output B8 1 16 2 8
T Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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I 7 Functions

The ignition controllers of the MIC4 series include freely configurable safety and auxiliary
functions that, amongst others, can shut down the engine in case of fault.

& Angle indications in the operating manual

All angles in this operating manual are given in °crankshaft. Exceptions are
clearly identified.

7.1 Pickup Sensitivity

To increase the signal interference distance, the sensitivity of the pickup signal inputs can be
changed for suitable pickup signals. This setting can be implemented individually for each
input. For this purpose, a pre-trigger voltage can be set below which signals are interpreted as
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus
result in a low pickup sensitivity level.

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine —
Pickups on page 99.

7.2 Monitoring of Pickup Signals

The MIC4 monitors the pickup signals. Any other errors are displayed in the MICT. For more
information on the errors, please refer to the overview in the section entitled Pickup Input Errors
on page 168.
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7.3 Go/NoGo

The binary output (Go/NoGo) is a potential-free output. It is closed during firing and opens when
the ignition switches off. The max. switching current is 100 mA. The output can drive an external
relay that e.g. opens a gas valve.

The following errors can cause the ignition outputs to shut down:
- Overspeed

- Pickup error

-  Error HV power supply

— Failure of the output monitoring

- Overload/temperature shut-down

- Alarms

- Insufficient supply voltage (Low Power)

) Use master control
The outputs of the MIC4 are not SIL compliant. Therefore, always use an
additional master control for safety-critical applications.

NOTICE

7.4 lgnition Timing Adjustment
The ignition controller has several functions for the timing correction.

& Influences on ignition timing
Be aware that the actual timing of the engine can also be influenced by
external signals (e.g., analog current or voltage input).

NOTICE

Operational safety!

The MIC4 ignition controller must first be correctly configured for the engine
being used before you can start the engine.

An incorrect configuration can result in damage to the engine.
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The figure below gives you an overview of the different functions of the timing correction, which
will be explained in more detail in the subsequent sections. Functions that can be
activated/disabled via the MICT are marked by a switch symbol. Depending on the device
version, some functions might not be available.

64

Per schedule:

| Base Timing

| Speed Curve

| Analog Voltage Input

| Analog Current Input

| Potentiometer

Global:

| Ignition Timing Correction

Per cylinder:

Cylinder Individual ——p

Limited by the
Offset J

min./max. cylinder
individual offset

Limited by the
min./max. Timing
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7-4.1 Manual Timing Correction

The ignition controllers of the MIC4 series include two permanently installed overwind-protected
potentiometers for manually correcting the ignition timing. The max. range is defined with the
corresponding limits that are set by the user. Potentiometer A adjusts the ignition timing of
schedule A and potentiometer B adjusts the igniting timing of schedule B.

7.4.2 Analog Inputs

The timing point control can be adjusted with a linear current signal. This signal can be
supplied, for example, by a potentiometer, a pressure sensor for charging pressure, or a
detonation controller.

With the analog process signal (current loop signal) at the analog current input, the timing point
can be offset in the advanced or retarded direction within a defined range.

Similarly or additionally, the timing can also be influenced by an analog voltage signal at the
corresponding input.

The levels of the analog inputs can be set in the range from o mAto 20 mAand o Vto 10 V. You
can make this configuration with the MICT. Please refer to the section Timing — Analog Inputs on
page 103.

At the voltage output (Analog Power), a configurable auxiliary voltage is supplied that can be
used for supplying power to external sensors.
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66

EXAMPLE

Configuration examples

In this example the analog inputs are configured in the Timing — Analog
Inputs window as follows:

— Input current: 4-20 mA
— Input voltage: 0-5V

Characteristic 4-20 mA / 0-5 V — Ignition timing adjustment toward
retarded.

BTDC
A
40° T 4mA oV
30° _—
Base Timing 30° BTDC
15° retarded ignition
15° |
20mA 5V
50
o° g

Characteristic 4-20 mA / 0-5 V — Ignition timing adjustment toward
advanced.

BTDC
A
40° 20mA 5V
0 —t—

30 15° advanced ignition

15 Base Timing 15° BTDC
4mA oV

50

o° g
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7.4.3 Cylinder-to-Cylinder Alignment
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders
to optimize their combustion.

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to
the chapter Cylinder Individual Offsets on page 154.

) Use of measuring unit
Use this setup option only if a suitable measuring unit is available for
determining the optimum timing point, so that the result of a change can be

NIOHGIE assessed immediately.

7.4.4 Speed Curve

To optimize the ignition, for example, during the start phase of the engine, a speed curve can be
defined for the MIC4 ignition controllers. To create this curve, up to eight adjustable speed
points are available.

You can configure the speed curve with the MICT. Refer to the section Timing — Schedule A/B -
General on page 105.

7.4.5 Ignition Timing Correction

There are two options for making corrections to the ignition timing:

- CANopen/Modbus/J1939
The field buses can be used to adjust the cylinder individual ignition timing points in 0.1°
increments by max. +/- 12.5 °crankshaft, restricted by the ignition timing point limits of the
current schedule.

- MICTvia USB
Please refer to the section Runtime Adjustments — Timing on page 150.

7.5 Firing Angles
The min. distance between two ignition angles depends on the overspeed. The smallest ignition
spacing per output bank can be calculated using the following formula:

0 d [min”*
Ignition Angle = %[mm] x360° x 1.7 ms

7.6 HV-Power Supply Error Monitoring
The voltage applied is monitored for excess voltage or low voltage by the integrated power
supply. For both errors a Power-Fail error is saved and the device shuts off.

Rev. 02/2020 67



I 7 Functions

7.7 Output Monitoring

Electronic switches are used for the ignition outputs of the MIC4 ignition controller If one of
these switches is defective, this would lead to a primary short or a primary open output. This can
cause problems when operating the engine or can damage the engine. The function of the
outputs is therefore monitored and errors that occur are displayed in the runtime data in the
MICT or can be transmitted via field buses. Different alarms are available for monitoring the
misfire rate. It can also be defined that the ignition is switched off in the event of output errors.
Refer to the section Inputs/Outputs — Alarms on page 109.

7.8 Schedules A/B
The MIC4 ignition controllers offer two separate schedules for the parameterization of the
ignition timing and energy.

By closing input Schedule A/B, the listed parameter settings for schedule B can be selected. A
possible application for this is e.g. operation with different gases. If only one schedule is
configured, this is used regardless of the switch position.

You can configure the schedules with the MICT. Please refer to Timing — Schedule A/B — General
on page 105 and Timing — Schedule A/B — Energy on page 107.

Operational safety!

If you use schedules A and B, the advanced timing point should be linked to
schedule B (switch closure). If a wire ruptures, schedule A is automatically
selected with the retarded (and thus safer) timing point.

7.9 Alarms

The MIC4 ignition controllers include 16 freely configurable alarms in total. These alarms can be
freely allocated to the general purpose output (GPO) and set depending on the following
functions:

- Limit for speed exceeded/not reached

- Limit for engine operating hours exceeded/not reached

-  Limit for spark plug operating hours exceeded/not reached
— Warning active

- Error active

- Limit for temperature exceeded/not reached

- Limit for supply voltage exceeded/not reached

- Limit for global ignition timing exceeded/not reached

- Limit on the analog voltage input exceeded/not reached
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— Limit on the analog current input exceeded/not reached

- Limit of the minimum spark duration exceeded/not reached

- Misfire rate (primary, single output) over limit

- Misfire rate (primary, all outputs) over limit

- Misfires per second (primary, all outputs) above threshold

- Consecutive misfires (primary, single output) above threshold

- Misfire rate (secondary, individual output) above threshold

- Misfire rate (secondary, all outputs) above threshold

- Misfires per second (secondary, all outputs) above threshold

- Consecutive misfires (secondary, single output) above threshold

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer
to the section Inputs/Outputs — Alarms on page 109.

7.10 GPO: General Purpose Output
The function of the general purpose output (GPO) can be set as desired as normally closed or
normally open. The GPO can be used for the freely definable alarms.

You can enter the settings for the general purpose output with the MICT. Refer to the section
Inputs/Outputs — Alarms on page 109.

7.11 ASO: Auxiliary Synchronization Output

The ASO is an output of the MIC4 for synchronizing the MIC4 ignition controller and a connected
control unit. The possible applications include detonation control, valve control, and fuel
injection control.

The ASO signal is low-active, i.e. the pulse width is defined as the time difference between the
raising and falling edge (pulse width = trising — traling). The raising edge of the signal marks the
configured engine rotation angle. With the variable pulse width, the values can be allocated to
the engine rotation angle. A max. of 16 pulses can be configured for this purpose.

The pulse width is known at the time of the active edge, as the falling edge of the signal
precedes the raising edge by the value of the pulse width. The controller calculates the duration
of the falling edge from high-level to low-level and then back to the starting value of the
high-level.

The ASO signal can be inverted via the configuration. It will then be high-active.

You can configure the auxiliary synchronization output with the MICT. Refer to the section
Inputs/Outputs — ASO1 (Auxiliary Synchronization Output) on page 111.
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EXAMPLE

Application of the ASO signal
The following example will illustrate the application of the ASO signal:
- Four-stroke engine with 6 cylinders

— Ignition angle 120° - 120°

Synchronization between MIC4 and Valve Controller

Ignition angle in ASO signal in Pulse duration in
°crankshaft °crankshaft us

1 0/720 718 160

2 120 118 80

3 240 238 80

4 360 358 80

5 480 478 8o

6 600 598 80

Schematic Representation (Standard Settings)

Level

160ps 8ops 8ops 8ops 8ops 8ops
W SEEET ~ e N S osass . [EEETED) s ) [EETTEH
High H : H ; H H
R EREREREE
Low | 1 0/720 i 120 1 240 1 360 ! 480 1 600 °KW
'-718 +-118 238 '-358 478 598

*) active edge

The valve controller should receive the active edge of the ASO signal before
the top dead center of a cylinder. The first pulse duration should be twice
as long and thus mark the beginning of a cycle. The ASO signal generated
by the MIC4 increases by 2° each time before the ignition signal from Low
to High, as can be seen in the schematic drawing. This edge is analyzed by
the valve controller as the active edge.

The ASO signal drops in accordance with the configured pulse duration
from High to Low before the active edge. The valve controller then has
already measured the pulse duration of the active edge and can provide
information on the allocation of the signal. In the example shown here, the
first cylinder is marked with a pulse width of 160 ps versus 8o ps for other
cylinders. If the valve controller measures a pulse width of 160 ps, the
subsequent signal is therefore allocated to the first cylinder. The next
signal then corresponds with the second cylinder in the ignition sequence,
etc.
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7.12 Ignition Energy
The ignition energy can be set separately for the start phase and normal operation. Here
different settings can be made for schedules A and B.

MOTORTECH

You can configure the ignition energy with the MICT. Please refer to the section Timing —
Schedule A/B — Energy on page 107.

7.13 Access Control
The MIC4 has four operating levels, three of which can be secured with different PINs. As a
default setting, the access control is not activated. If the access control for the MIC4 is activated,
itis independent from the access levels that control authorizations within the MICT.

Access control in the MICT and on MIC4

A useris logged in to the Advanced Service access level on the MICT. He
changes a configuration and would like to download the change to the

EXAMPLE

MIC4. Although he has the full authorization set in the MICT, he is prompted

to log in with the PIN for the Level 3 (Master) on the MIC4.

A variety of functions are at your disposal in the four operating levels of the MIC4 . The figure

below illustrates this:

Level o: Read Only

Runtime Data

All

Level 1: Operator

Level 2: Service

Runtime Adjustment

Level 3: Master

Runtime Adjustment

Timing
Energy

Commands

Commands

Reset Position

Configuration

Alarm Commands
Error Commands
Misfire Counters

Set Engine Hous
Set Spark Plug Hours

Access Control

Login

Timing

Cylinder Individual
Offsets

Download to Device

Access Control

Self Test

All
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Reset All PINs
Enable Access Control
Disable Access Control
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The following functions are available on the different levels:

Level o (Read Only)
Enables read-only access for all users.

Level 1 (Operator)
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on
this level.

Level 2 (Service)

Only the Service level has access to modifications of the runtime adjustments for Timing and
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual
Offsets and the Settings for Self Test can also be executed in this operating level.

Level 3 (Master)

On this level, the Master can, in addition to the other adjustments, modify the Reset Position
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to
transfer a configuration to an ignition controller.

For information on the access levels in the MICT, refer to the section Access Levels in the MICT on
page74.
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MICT is an abbreviation for MOTORTECH Integrated Configuration Tool. With the MICT, you can
configure your ignition controller, and you can view and adjust the operating data of your
engine. When working with the MICT, you can press the F1 key at any time to access
context-sensitive help.

If you are using a different version of the MICT than shown in the following sections, the scope of
functions may differ.

8.1 MICT System Requirements
For the installation of the MICT, the following minimum requirements must be fulfilled:

- x86-compatible PC, at least performance class Intel Pentium 4 with 2 GHz
- 128 MB free RAM

- 250 MB free disk space

- USB interface 1.1 or higher

— Display with a resolution of at least 1440 x 900 pixels (WXGA+)

—  Microsoft® Windows 7, Windows 10

8.2 MICT Installation
The software for the installation of the MICT is on the storage device (USB flash drive or CD-ROM)
provided with the ignition controller.

To install the MICT, proceed as follows:
1. Start the installation:

- Viathe menu:
Start the file Start.exe on the storage device. Start the installation routine of the MICT
via Software -» Install MICT.

- Directly from the storage device:
Start the installation routine of the MICT directly. It is on the storage device in the
subdirectory Installation and for example named as follows: MICT-2.0.0-setup.exe.

2. Run the installation.
Follow the instructions of the installation routine. Note that the license agreement terms
must be accepted before using the MICT.

3. Install the USB driver via the menu as well or directly from the storage device.

- Viathe menu:
Software -» USB Drivers -» Install USB Drivers

- Directly from the storage device:
Start the exe file in subdirectory Drivers(e.g. CDM21226_Setup.exe).

> The MICT is set up. You can connect your PC to the ignition controller via the USB
interface.
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8.3 Access Levels in the MICT
You can open the MICT on your PC via Start -> Programs ->» MOTORTECH -> MICT 2.x.x -> MICT 2.x.x.

After opening the MICT, select the access level for which you have clearance. The access level
controls the options you have at your disposal in the MICT. The password required for access
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on

page 169).
M! Change Access Level =]
Access Level
@ Read Only
Customer
Service
Advanced Service
Password:
Lo ]

The following access levels are available:

Read Only

On this level, the user can open a configuration and transfer it to the device. However, he
cannot make changes to the configuration. The user has read-only access to all other
settings.

Customer
This level enables the configuration of the basic functions required for operation in addition
to the read-only function.

Service
This level contains all functions for a standard installation.

Advanced Service
This level offers full access to all functions of the MICT and is enabled and accessible for
specially trained personnel only.

The following sections describe the options at your disposal with the Advanced Service access
level. If you have registered for a different level, you cannot execute all functions shown.

74
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8.4 Configuration Pages (Overview)
The configuration pages are divided into the following sections:

! unnamed.mic4 (MIC4x1.08) - MICT =)

n—"ﬁle Device _Settings _Document _Tools _Help
B  a&-S8S ji9SE00lF
Configuration Page e ) )
- Engine Selection Engine Information
o
| Paramete Series Type g 5 ! y
" Cylinder Names
gt AJAX Engine Type: 4-stroke engne
[ Ignition Outputs e
1 Ignition Coils Clark
Bl Do B s 4
4 Timing m
: Analog Inputs Guascor
=~ Ingersoll Rand
FE; S\"""“"A Jenbacher
{1 General Liebherr
[ Energy MAN
4 [ Schedule B B
= Sequence
] General Ealin
- uperior
_ 1 Energy Waukesha
| Miscellaneous
4 Inputs/Outputs
] Alarms
) asor
) Inputs

4 Miscellaneous
= S
Communication

[ Information @

MOTORTECH does not assume kiability for the information in the engine database. Please contact MOTORTECH if discrepandies

@ are found.

If your engir inthe please.

@ COM3 ID MIC4x1.08 (1.5.1 [00002801]) ADV.SERVICE Full Access Version: 2.7.00000 -'—B

Item no. Area

Menu bar

Toolbar

Navigation bar
Configuration section
Status bar

The functions in the menu bar, navigation bar and the toolbar as well as the configuration
section will be described in the following.
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The status bar provides you with the following information (from left to right):

- Status display
Indicates whether a connection is established with the device:

— Green: Connection established

— Red: The connection was interrupted and is being restored

— Gray: The connection is not established and is not being restored

— Indication of the interface being used for the connection to the device

- Indication of the device ID

— Indication of the access level of the user in the MICT

— Indication of the operating level for the MIC4 if access control has been activated and the
user has logged on with a PIN.

— Indication of the MICT program version

8.5 Menu Bar and Toolbar

The following functions are available to you via the symbols on the toolbar and the entries in the

menu bar:

Symbol

&

)

76

Menu

File -> New

File -> Open

File -> Save /
File -> Save As

File -> Recent Documents

File -> Close

File -> Open trace

File -> Open pickup trace

File -> Change Access Level

Function

Creates a new configuration.

Opens an existing configuration.

Saves the current configuration.

The last five configuration files used are
offered for selection.

Closes the current configuration.

Opens a runtime data record (trace file). Refer
to the section Runtime Data on page 118.

Opens a saved record of pickup signals
(putrace file). Refer to the section Pickup Trace
on page 82.

Changes the MICT access level for accessing
the configuration data and functions.

Rev. 02/2020



I 8 Settings via the MICT

Symbol Menu

File -» Print

File -»> Print To PDF File

@

File -»> Print Preview
File -» Quit
g] Device -» Connect
E] Device -» Disconnect
@\"A Device -» Download to device

Device-> Upload from device

— Device -» Runtime data

d Device -5 Log

— Device -» Runtime adjustments

Device -» Cylinder individual
offsets

Device -» Self test

Rev. 02/2020
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Function

Prints the current configuration.

Prints the configuration to a PDF file.

Opens a print preview of the configuration.
Exits the MICT.

Connects to the device.

Cuts the connection to the device.

Downloads configuration data from the PC to
the device. Refer to Working with
Configurations on page 86.

Uploads configuration data from the device to
the PC. Refer to Working with Configurations
on page 86.

Opens the window Runtime Data. Refer to the
section Runtime Data on page 118.

Opens the window Log (Advanced Service
only). Refer to the section Log on page 147.

Opens the window Runtime Adjustments
(Service and Advanced Service only). Please
refer to the section Runtime Adjustments on
page 148.

Opens the window Cylinder Individual Offsets
(Advanced Service only). Please refer to the
chapter Cylinder Individual Offsets on

page 154.

Opens the window Self Test (Service and
Advanced Service only). For this read section
Self Test on page 80.
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Symbol

78

Menu

Device -» Pickup trace

Device-» Set spark plug operating
hours

Device -» Set engine operating
hours

Device -» Set date and time

Device -» Send command - Reset
misfire counters

Device -» Send command -»
Acknowledge operational error

(Keyboard shortcut: Strg+R)

Device -» Access Control

Device -> Temperature Extremes

Settings -> Language

Settings -> Online update settings

Settings-» Database settings

Settings -» Temperature scale

Function

Loads the automatically recorded pickup
signals from the device. Refer to the section
Pickup Trace on page 82.

Opens the window Set spark plug operating
hours.

Opens the window Set Engine Operating
Hours.

Opens the window Set Date and Time, in which
you can set the clock in the device.

The misfire counters of all ignition controller
outputs are reset and restarted. Misfires that
previously occurred at the outputs are no
longer displayed.

All operating errors are acknowledged. This
can only be implemented while the engine is
not running.

The setup for the access control to the MIC4 is
described in a separate section. Please read
the section Access Control for MIC4 on

page 84.

Opens the window Temperature Extremes in
which the minimum and maximum
temperatures of the controller and output
boards are displayed.

Opens the window Select Language in which
you can change the interface language of the
MICT.

Opens the window Online Update Settings.
Refer to the section Online Update Settings on
page79.

Opens the window Database Settings in which
various databases can be assigned as source
for the MICT.

Opens the window Select Temperature Scale,
in which you can change the unit for the
temperatures shown in the MICT.
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Symbol Menu Function

Settings -»> Display by cylinders Not currently used.

| Document -> Schedule Curve Opens the window Schedule. Please refer to
the chapter Schedule Curve on page 155.
Tools -» Coils Opens a database with information on
MOTORTECH ignition coils.
Help -> Help Opens the online help function.
Help -> About MICT Opens detailed information on the MICT.

8.6 Online Update Settings

& Perform regular online updates
MOTORTECH is constantly expanding its databases. Perform regular online
updates to make optimal use of the opportunities that the MIC4 provides.

NOTICE

The MICT uses data from an engine database and a coil database for the configuration. Such
data can be updated with automatic online updates. The settings for the update can be entered
with the following entry in the menu bar:

Settings -> Online update settings

M! Online Update Settings —

[¥] Enable automatic database updates

[7] Use a proxy to access the web

http-Proxy:
Port:

o) Coma)

You have the following options:

— Enable automatic database updates
Using the check box, you can enable and disable automatic online updates. As the default
setting, the online update is activated and is executed daily (if an internet connection is
established) at first start-up of the MICT.
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— Use aproxy to access the web
Use the checkbox to activate settings for internet access via a proxy server, which you can
then set up by entering http-Proxy and Port.

— Show Log
With this button, you can open a window in which the online updates performed are logged.

— Update Now
With this button, you manually start an online update.

8.7 Self Test

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber.
Non-compliance can result in damage to equipment or injury to persons.

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs.

Proceed in the MICT as follows:

Device -» Self test

M Self Test o | B )

WARNING

In using the self test feature it is citical that the fuel to the engine
has been shut off and the engine purged of any fuel gas. Failure to do
this could result in damage to equipment and nearby personnel!

Status Cydes Cyde Time - All Configured Outputs
@ Unlmited © period 500000 (&) bS
© Locked =
1[5 Frequency 2.000 (7 Hz
QO Actve  Outputs Control
o Ready

© Al
> (6 -] (¢4] (0]

@ COM3 D MIC4x1.08 (1.5.1 [0000a801])
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The following information is provided:

Status
The status displays indicate whether the ignition controller is ready for the self test.

Locked

£ MOTORTECH

The ignition controller is in a state in which no self test can be done. For example, there is an

error or a configuration is currently being downloaded into the device.

Active
The self test is running.

Ready
The ignition controller is ready and the self test can be started.

You have the following options:

Cycles
Determine whether the self test should run unlimited or be terminated after a defined
number of cycles.

Outputs
Define whether all outputs or only a defined output should be fired during the self test.

Cycle Time - All Configured Outputs

Specify the cycle time either as a period or frequency. The value entered always refers to a
complete cycle. That means that all outputs that are configured are fires once per cycle. If
you only set one output for the self test, this would still only fire once per cycle.

Control
Start or stop a self test using the corresponding buttons.

Rev. 02/2020

81



I 8 Settings via the MICT

8.8 Pickup Trace

The traces of the pickup signals support you in checking the behavior of the used pickup and
thus, for example, to detect and analyze irregularities or failures.

Pickup signals are automatically recorded by the ignition controller as soon as they are detected
at the configured inputs. Ten further signals are recorded if an error occurs during operation
(cumulative across all inputs). The recording is then stopped so that the pickup signals just
before the error can be analyzed. The records can be downloaded from the device at any time.

Proceed in the MICT as follows:

Device -» Pickup trace

Pickup trace
Example of a pickup trace for a configuration with three pickups:
- Pickup input 1 (cam):
EXAMPLE Single event from the camshaft
- Pickup input 2 (reset):
Single event from the crankshaft
- Pickup input 3 (trigger):
Trigger disc of type N with 160 events from the crankshaft

M MICT Pickup Trace o | B |

Eile

Pickup Trace

w

o {{TLLCELEELEEEEEEERELE T ELEE R ER R TR LR LR L ]

Pickup Input

]| €18 811 [RGB RE [N 81 18 ][ 8 8811518515 1 {1 8] =4[54 )18 |

T T T T T
0 2.000

T T T T T T T T T T 1
4.000 6.000 8.000 10.000,

Time [ms]

Operation
The following options are available via the menu in the window:

- Open
Opens a previously saved pickup trace.

- Saveas
Saves a pickup trace as a .putrace file.

- Close
Closes the pickup trace.
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There are the following options for the display of the pickup signals:

Zoom In/Out

MOTORTECH

Using the mouse scroll wheel you can zoom in and out of the displayed record range.
Alternatively you can also use the plus and minus keys on the keyboard. With the zoom
function, you can e.g. analyze the trigger signal more precisely (pickup input 3 in the

drawing).
(M MICT Pickup Trace =
Eile
Pickup Trace
3 ] 00000 0 A AT
5
a2 | |
3
B
1
o |
T T U U T T o U T T s T o Ve T s
4.940 4.960 4.980 5.000 5.020 5.040 5.060
Time [ms]

Move displayed range

With the right mouse button pressed you can move the displayed range along the time axis.

Measuring

You can measure distances and the number of events in the displayed range by holding
down the left mouse button to highlight a section. You can find the following information in

the window:
— Position on the time axis
- Time difference (A) between the two selected points

- Number of events counted in the selected period

M MICT Pickup Trace =

Eile

Pickup Trace

w

| sma3ims

i 4 = 1947.019 ms
LA EREEEE LT L L Ll L] JE2 ]

H Input 1 (positive): 11 events, min. period: 159.276 ms, max. period: 213.162 ms
H Input 2 (positive): 22 eventd, min. period: 79.637 ms, max. period: 114.677 ms

LA TEA LT i i i g S sy

Pickup Input
N

o

s e S S e e e e e e e TS e e
2.000 3.000 4.000 5.000 6.000 7.000 8.000

Time [ms]
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Error Analysis
The pickup traces support you, for example, in analyzing the following errors:

Configuration of the pickup does not agree with the wiring (e.g. trigger disc configuration,
allocation of the inputs, allocation of the shafts). In this case, you should compare the
values configured with the signals recorded (see Engine — Pickups on page 99).

One or more pickups have failed.

& Pickup trace

The pickup signals are only recorded on the inputs that are configured in
the MICT. If the configuration of the pickup inputs is not valid (e.g. three
signals from the same shaft), no signals are recorded.

8.9 Access Control for MIC4
If the access control to the MIC4 is activated, access to the following areas is possible with a PIN
only:

Runtime Adjustment (Reset, timing, energy, secondary voltage estimation calibration and
secondary short calibration)

Commands (Alarms, error commands, set engine/spark plug operating hours, and self test).

Configuration (Transferring a configuration to the MICg)

The access control regulates the accesses to the device via the MICT. For explanations
concerning access control of the MIC4 and the delimitation of the access levels in the MICT, refer
to section Access Control on page 71.

The access control functions can be accessed in the menu bar via:

Device -» Access Control

8.9.1 Enable/Disable Access Control

84

& Enable/Disable access control

As a default setting, the access control is not activated, and all PINs are set

to 0000. Once the access control has been activated, and the PINs were
changed, these PINs will continue to be used. To activate the access control
again, you will need the PIN for level 3 (Master). It is therefore
recommended to reset all PINs before disabling.

If that was not done, or a system must be unlocked for another reason, a
request key can be issued in the MICT. Refer to the section Reset all PINs on

page 8s.
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To enable or disable the access control, proceed as follows:

1. Open theinput dialog via Device -» Access Control -> Enable or Disable access control.
2. Enterthe PIN for the level Master (Level 3).

3. Confirm the input with OK.

8.9.2 Login/Logout

If the access control is activated, you are prompted to log in if you want to execute functions that
are allocated to a specific operating level. In addition, you can log in specifically to an operating
level via the menu bar.

To log into a specific operating level, proceed as follows:
1. Open the input dialog via Device-> Access Control -»> Login.
2. First select the level you wish to log on to.
Enter the PIN for the desired level.
4. Confirm the input with OK.
> You are now logged into the corresponding level and can execute all functions that are
allocated to this operating level without having to log in again.
After completing the log-in, you can log out again as follows:

Device -» Access Control -» Logout

8.9.3 Changing the PIN

To change the PIN for a specific operating level, proceed as follows:

1. Open theinput dialog via Device -» Access Control -» Change PIN.

2. First select the level for which you wish to change the PIN.
3. Enterthe current PIN for the desired level.

4. Enter the new PIN in the two subsequent fields.

5. Confirm the input with OK.

> The PIN for this operating level has now been changed.

8.9.4 Reset all PINs

To reset all PINs, proceed as follows:
1. Open theinput dialog via Device -»> Access Control -> Reset all PINs.

2. Ifyou are not yet logged into the Master (level 3) level, you will be prompted to log in with
the relevant PIN.

3. Confirm the input with OK.
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4.
5.

To reset all PINs, you will be prompted again to enter the PIN for the level Master (Level 3).
Confirm the input with OK.

» AllPINs are now reset to the value oooo.

To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in
case of emergency that was locked in this way, you have the following option:

1.

In the menu bar, select the entry Device -» Access Control -> Get reset all PINs request key to
open a window with the same name.

Send the request key with the serial number to your service contact person at MOTORTECH
(refer to Customer Service Information on page 169). This key is valid only for the respective
controller and only for a certain amount of time.

> Your information will be verified, and you will receive an authorization key from your
contact person.

From the menu bar, select the entry Device -» Access Control -> Set reset all PINs
authorization key to open a window with this name.

Enter the authorization key received in the input field.
Confirm the input with OK.

» Ifthe input was correct, all PINs are reset to the default value oooo.

8.10 Working with Configurations

To ensure that the MIC4 correctly interprets incoming data and correctly controls the ignition
system, it requires information about the engine and the ignition system. This information is
stored in the MIC4 as configuration data.

You can use the MICT to perform the following for these configurations:

86

Create

Open

Edit

Save as a file
Download to the MIC4
Upload from the MIC4
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8.10.1 Create, Open, Save
Click on the symbol to create a new configuration and select the corresponding
device type. The device type corresponds to the first five digits of the
arrangement number, which you can find on a label on your device.

&

Rev. 02/2020

M Select Device Type

==

Select the device type you want to configure:

4 Ignition Controllers
b MIC3
> MIC3+
4 MIC4
MIC4x1.08 (8 outputs)
MIC4x2.12 (12 outputs)
MIC4x2.16 (16 outputs)
MIC4x2.16 ZS (16 outputs)
b MIC4+
> MICS
> MIC850
4 Stepper Motor Cards
VariStep
VariStep3

(o ][ comeel |

MOTORTECH

Click on the symbol to open a saved configuration.

|_ engine3.mic4

Dateiname: enginel.mic4

! Open Configuration File =]
@Qv\ ) » Computer » OS(C) » Configuration Files <% [ Confise urchsuchen P
Organisieren v Neuer Ordner =~ A @

Name . Anderungsdatum  Typ GroBe
| ] enginel.mic4 01.09.2015 14:46 MIC4-Datei 14K8|
|| engine2.micé 01.09.2015 14:46 MIC4-Datei 14KB
01.09.2015 14:46 MIC4-Datei 14K8

~ | All Configuration Files (*.002*( v

Click on the symbol to save the configuration currently displayed in the MICT to

a storage device.
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Compatibility of the configuration files

Configuration files are only compatible for the respective device type, even
if the file extension is identical. For example, files created for a MIC3 cannot
be downloaded to a MIC3+ and vice versa.

To use a configuration for another device, the series and the first four digits
of the arrangement number must match. This information can be found in
the title bar of the configuration and on the respective device:

MIC3 MIC3+

M unnamed.micg® (MIC3x1.12) MICT M unnamed.mic3MIC3+ 3x1.12)) MICT

File Device Settings Document Tools H File Device Settings Document Tools
]

SR 2Pl SI=F- 3--P3 1

iConligura(ion Page | Parameters

‘ Engine Sel¢

} Parameters

| Configuration Page
| ‘ Engine Sel¢

| 4 Engine | 4 Engine

EMOTORTECH 32 EmoTorTECH

| : | | : |
G AN 3x1 .12§xx~xxxx-xx»x | d AN 3x1 .12§xx~xxxx-xx»x |

www.motortech.de
www.motortech.de

If, for example, a system is to be changed from a MIC3 to a MIC3+, the
configuration of the MIC3 can be saved as a PDF file. Then a new
configuration file must be created for the MIC3+ and the values from the
PDF file must be entered. Alternatively, the MICT can be opened twice and
the values transferred to a newly created configuration file.

8.10.2 Upload, Download
< Click the symbol to upload the current configuration from the MIC4 to the MICT.

§§] If applicable, the MICT first establishes a connection to the MIC4 connected.
%\AA Click on the symbol to download the configuration set in the MICT to the MIC4.
g} This function can only be executed while the ignition is not active. This action

overwrites the existing configuration on the device. If applicable, the MICT first
establishes a connection to the MIC4 connected.
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& Existing configuration is cleared!
If you download a configuration to a MIC4, the previous configuration is
deleted and the new settings are immediately implemented.
NOTICE
) Runtime adjustments
If you change a configuration stored in the MIC4 via runtime adjustments,
the configuration must be re-uploaded from the device so that the changes
SRETICE are displayed in the MICT's configuration views.

8.10.3 Compatibility Information
'g Information )

@  Some optional configuration values could not be uploaded from the device.
Assuming default values.

If you upload a configuration from the MIC4 to the MICT that does not correspond to the status of
your MICT, or if you open this type of configuration in the MICT, the following situations may
occur:

— Novalues are present in the configuration for certain MICT functions. The MICT assumes the
standard values for these functions.

- The configuration contains function values that are not support by the MICT.
The following situations can occur if you download a configuration from the MICT to a MIC4
whose firmware does not correspond to the status of your MICT:

— Novalues are present in the configuration for certain firmware functions. The firmware
continues to use the preset values for these functions.

- The configuration contains function values that are not support by the firmware.
If you download a configuration into the MIC4 and are notified of functions that are not

supported by the MICT, you should check the MIC4 settings. Re-upload the configuration from
the MIC4 to the MICT. You can then see which settings are not transmitted to the MICT.

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the
MIC4 functions without restriction.

Rev. 02/2020 89



I 8 Settings via the MICT

8.11 Configuration

The window opens after you select the device type for a new configuration or an existing
configuration or have uploaded one from the ignition controller. You can make changes to the
configuration by selecting an entry from the navigation bar. The corresponding configuration
data are then displayed in the configuration section and can be processed. The following
sections will describe the settings and adjustments you can implement in the different areas.

) Indication of invalid entries

An invalid selection or invalid input values are highlighted by pulsating
warning signs on the configuration pages of the MICT. Additional
information is provided in the status bar.

Example:

4 |Miscellaneous :
N s [V]Rs48s
Communication

| Service Contact RS485 Mode RS485 Settings

© vous ot
= -

Modbus Settings
Modbus Address: 1

vose:

5485 Stop bits (Default = 1) (invalid due to context) @ COMn/a IDn/a ADV.SERVICE n/a Version: 2.7.00000
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8.11.1 Engine — Parameters

MOTORTECH

M unnamed.mic4* (MIC4x2.16) - MICT

File Device Settings Document

Configuration Page
+ [Engine
| Parameters.

" Cylinder Names
7 Ignition Outputs
" Ignition Coils
" Pickups
4 Timing
" Analog Inputs
4 [} Schedule A
| General
| Energy
4 [ Schedule B
| General
| Energy
7 Miscellaneous
4 Inputs/Outputs
7 Alarms
7 Aso1
7 Inputs
4 Miscellaneous
" Communication

" Information

Tools Help

AHSES %S A0

Engine Selection

—— S )

AJRX E08 Series E2848LE322

Caterpillar E28 Series E2876E302

Clark E2876E312

Cooper Bessemer E2876LE202

™M E2876LE302

Guascor E2876TE302

Ingersoll Rand

Jenbacher

Liebherr

MAN

Nordberg

Sequence

Superior

Waukesha

/i\ MOT(S‘R;EW does not assume liability for the information in the engine database. Please contact MOTORTECH if discrepancies
are 5

If your engine is not available in the list contact MOTORTECH service please.

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Engine Information
Selected Engine Summary
MAN - E2848LE322

Engine Type: 8 cylinder 4-
stroke V engine

Firing Angles
0.0

90.0
180.0
270.0
360.0
450.0
540.0
630.0
0.0

Engine Selection

The MICT holds an engine database with data from various manufacturers and model series.

Select the desired engine manufacturer, series, and type by clicking on the corresponding fields.

Wiring in firing order is assumed as standard. If straight order wiring is supported for the
selected engine, the Wiring dialog opens and you have the opportunity to adapt the output

configuration.

Rev. 02/2020
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M Wiring (L9 [

Please select the type of wiring you are using.

In case of custom wiring please select wiring in firing order and adjust the output configuration
afterwards.

wired in firing order

© wired in straight order (user defined orientation)

Coil 1 7|0 o 1
8[|0]| |O]||2
9l [O] [Of |3
10| (O Ol |4
1| |0 o S
12| O Of |6 Coil 1
Cyl. 58 (LI TICD Cyl. 1-4
Cyl. 7-12 Flywheel Cyl. 16
[ change orientation of rail ] l change harness ] ’ change orientation of rail ]

Lo ]

You can use straight order wiring, if:

—  Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the
wiring rail are marked with Connector Pin 1 to Connector Pin X. The position of coil1 on the
wiring rail is marked in the view Wiring.

— Wiring of the ignition controller is done corresponding to the instructions in section Straight
Order Wiring of the Ignition Outputs on page 57 (for example with an open wiring harness or
via a junction box).

The configuration of the ignition outputs is automatically adapted corresponding to your
selection. If you want to use a different wiring, these settings must be adapted appropriately.

If the pertinent engine is not available in the database, settings can also be entered by selecting
the corresponding sequence. For this purpose, click on the entry Sequence in the column Engine
Manufacturer and select the firing stroke in the column Series, then the number of cylinders,
and the ignition offset of the engine as needed. After making your selections, the right hand
section Engine Information will display a summary of the parameters selected.

The summarized data are transferred to the subsequent configuration page /gnition Outputs.
The values displayed there can only be changed by users with authorization to access the
Advanced Service level.

92 Rev. 02/2020



I 8 Settings via the MICT = MOTORTECH

Engine database

MOTORTECH does not assume liability for the information in the engine
database. Please contact MOTORTECH if discrepancies are found.

New Engine Configuration

Staff with the authorization for the Advanced Service level additionally has the option for
entering the engine data manually, i.e., without selecting entries from the engine database. For
this purpose, click on the New Engine Configuration button and select the engine type, number
of cycles, and number of cylinders in the dialog box opening up. Additional information can be
entered on the configuration page Ignition Outputs.

EE =X
Engine Type: [vengine )
Strokes: [%troke N2 ]
Number of Cylinders: [ 16 N7 ]

Note: Specify Firing Order and Firing Angles on the Ignition Outputs Page!

(oc J[ comeel ]
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8.11.2 Engine — Cylinder Names

M unnamed.mic4* (MIC4x2.16) - MICT

File Device Settings Document Tools Help
AEF5S A% E0

Cylinder Names

Configuration Page

4 Enging [¥] Enable Cylinder Names
| Parameters

B Cylinder Names Bank Name: B Bank Name: A

| Ignition Outputs

| Ignition Coils o 1%

Pickups o a

4 Timing i 8

Analog Inputs

4 [T Schedule A &

General

7 Energy
4 [ ScheduleB 1

| General

| Energy

[0 0 0 0 0 0]
[0 0 0 0 0 0]

" Miscellaneous
4 Inputs/Outputs Flywheel
Alarms

| ASO1L

Inputs

4 Miscellaneous

Communication

" Information

[7] Show banks in reverse order

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you
can individually name each cylinder. The schematic representation of the plan view of the
selected engine supports you in this. Enter the following settings:

94

Enable Cylinder Names

Activate the checkbox in order to assign cylinder names. In order to use this function, the
number of cylinders must be defined. Establish the number of cylinders either by using a
configuration from the engine database or by creating a new engine configuration via the
corresponding button. Refer to the section Engine — Parameters on page 91. If you have
activated the checkbox, the assigned cylinder names must also be assigned to the
corresponding ignition outputs, before the configuration is transferred to the ignition
controller. Otherwise there will be an error message. Refer to the section Engine - Ignition
Outputs on page 95.

Bank Name
Enter a name for the respective cylinder bank.

Cylinder Names
Enter a name for the respective cylinder.
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o®
- ©3

currently not used

— Show banks in reverse order
currently not used

8.11.3 Engine - Ignition Outputs
M! unnamed.mic4* (MIC4x2.16) - MICT (==

File Device Settings Document Tools Help

JeEHSHHS 8%t a0

Configuration Page lontoq Outputs,
+ lEngine OutputBank A OutputBank B
) Ve - -
| Cylinder Names
e
. lgnition Ortputy Cyinder Output Angle [9 Ange [9] Output Cyinder
Ignition Coils
w 5 (2 BIE v 00 450.0 [+ ¥z )
ickups
4 Timi 2 v)[s v 4800 210.0 2 ¥[8 -
Timing
] Analog Inputs E BE ] 2900 690.0 (s 2IB )
<0 ,thzdu“AI (2 BIG ] 6000 3300 [3 v [10 ¥
) tnergy [ Jk <) 10 510 B Bl 3
4 [3) Schedule B (6 ¥ (2 ] 360.0 90.0 [ ) (2 )
; General notassigned v | |7 ¥ ||0.0 0.0 7 v | [notassigned ¥
_ [0 Energy notassgned  ~ | [ ~] [0.0 0.0 8 ~) [notassgned  ~
| Miscellaneous
4 Inputs/Outputs
7 Alarms
3 Asol
7 Inputs

4 Miscellaneous
| Communication
" Information

@ COM3 IDMIC4x2.16 (1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Make adjustments to the following settings as needed:

—  Number of Outputs
Select the number of outputs for the respective output board.

— Column: Cylinder
Select a cylinder. The displayed names are specified on the configuration page Engine —
Cylinder Names.
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- Column: Output
Select the number of the respective output.

—  Column: Angle
Enter the firing angle for each output.

Default Application

If you select from the engine database, the data stored for the selected configuration are
displayed. These data can only be changed by personnel with access to the Advanced Service
level.

New Engine Configuration

If you have created a new engine configuration on the configuration page Engine — Parameters
using the corresponding button, first the number of outputs corresponding to the number of
cylinders are distributed to the output bank A and output bank B. Selecting the number of
outputs enables access to the fields for the configuration of the outputs. We recommend that
you distribute the number of outputs evenly among the output banks and allocate the larger
number to the A output bank if the number is uneven.

By default, the ignition outputs are distributed so that cylinder 1 of the firing order is always
allocated to output bank A with a firing angle of 0°. The further distribution is implemented by
alternating between output bank A and B. The firing angle for each output results from the
addition of the firing interval to the respective previous output.

Operational safety!

Never connect more than one output to each ignition coil, as the output
boards can otherwise be damaged!

The allocation of outputs on the output banks to contacts of the output connector of the device
and the cylinders is determined by the wiring. The user must take the wiring into account during
the configuration; it cannot be checked by the software.

Interval between two ignitions

The interval between two ignitions on an output bank must be min. 1.7 ms.
During the check, the configured overspeed is used in the calculation.
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8.11.4 Engine - Ignition Coils
(M1 unnamed.micd* (MIC4x2.16) - MICT (==

File Device Settings Document Tools Help

AT, RN EO

Configuration Page Ignition Coils
4 Engine Ignition Coil Type
| Parameters Coil Type: [06.50.104 v [¥] secondary Diagnostics Enabled

Cylinder Names
S s Secondary Voltage Estimation Calibration
Ignition Outputs

| Ignition Coils, Output Offset Output Offset

| Pickups A1 0.2 $ 81 0.0 S
4 Timing

S A2 . $ B2 : 2

| Analog Inputs o .

4 [ Schedule A A3 0.0 % B3 0.0 2
| General A4 0.4 ¢ B4 0.0 &
| Energy AS 0.0 = BS 1.0 -

4 [ ScheduleB
\ A6 0.0 = B6 0.5 2

General
| Energy A7 0.0 2 B7 0.0
| Miscellaneous A8 0.0 : 88 0.0
4 Inputs/Outputs v
- Alarms Secondary Short Detection Calibration
| ASO1L
; Secondary Short Enable Voltage: 0.420 |51 kV
Inputs
« e Secondary Short Sensitivity: 0.9996 [+

Communication

" Information

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Ignition Coil Type
Select the ignition coil type from the drop-down list. (Without this selection the configuration
cannot be downloaded to the MIC4.)

Only use measured ignition coils

To operate the MIC4, only ignition coil types measured by MOTORTECH may
be used. Allignition coils used must correspond to the part number
selected in the drop-down list. Different coil types must not be mixed and
also no equivalent or replacement types may be used.

If a coil type used is not in the drop-down list, then the MIC4 is currently not
used.
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Secondary Diagnostics Enabled

The secondary diagnosis can be deactivated and activated for ignition coils that support this
function. If the ignition coil does not support this function, the secondary voltage estimation
calibration and the of the secondary short calibration are not available.

Secondary Voltage Estimation Calibration

A correction value without units can be set for the secondary voltage estimation for every
configured output to increase the accuracy of the secondary voltage estimation for each
individual cylinder. This allows, for instance, different cable lengths on the engine to be
compensated.

The values of the secondary voltage estimation can be changed for each individual cylinder. The
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You
can adjust the secondary voltage estimation while the engine is running in the runtime
adjustments (refer to Runtime Adjustments — Secondary Voltage Estimation Calibration on

page 152).

Secondary Short Detection Calibration

The starting voltage and the secondary short detection sensitivity can be adjusted. You can
adjust the secondary short detection in the runtime adjustments while the engine is running
(refer to Runtime Adjustments — Secondary Short Calibration on page 153).

Secondary Short Enable Voltage
Set the average ignition voltage required to activate the secondary short-circuit monitoring:

— The secondary short detection is always activated at a value of o kV.

— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.

— The sensitivity is low at a value of 1.02.
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8.11.5 Engine — Pickups

MOTORTECH

" Cylinder Names =)

| Ignition Outputs Input 1 (Cam): trigger disc type SINGLE EVENT and active high pick up on camshaft

Y Ignition Coils Input 2 (Reset). trigger disc type SINGLE EVENT and passive pick up on crankshaft

i _9nion. Input 3 (Tigger): trigger disc type N with 160 events and passive pick up on crankshaft
| | Pickups

4 Timing Pickup Setup

" Analog Inputs Predefined Setup: (3PU ) [ User-defined

4 [ Schedule A

M! unnamed.micd* (MIC4x2.16) - MICT (==
File Device Settings Document Tools Help
S Q .;’ sd4 O B 5 = d 7] [O
| @ & ¥ CRSC / |Ed|HIe)
Configuration Page Pidaxps
- e Pickup Setup Information
7 Parameters 3PU (N events (passive) and 1 reset event (passive) from crankshaft and 1 event (active high) from

*H—— Index/Reset Position:  60.0
" Energy Pickup Sensitivity:
4 [ ScheduleB
B General Trigger No. of Triggers: 160
| Energy
7 Miscellaneous
el lanOMpm
il Alams Aux Pickup Supply Voltage
] ASO1
5 Aux Pickup Supply Voltage: 24.0/% V
Inputs
4 Miscellaneous Speed Settings
" Communication .
3 Information oo Reicase:/l 40
Security Speed: 250
Nominal Speed: 1500
Overspeed: 1800
Max. Power-On Speed: 6000
@ COM3 IDMIC4x2.16 (1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000
& Active pickups
Check when using active pickups that the auxiliary supply voltage is
configured for your application.
NOTICE

Pickup Setup Information

The settings made in the section Pickup Setup were summarized once again in the section

Pickup Setup Information.
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Pickup Setup
Enter the following settings in this section:

Predefined Setup
Select the pickup configuration suitable for your application from the list. The
configurations available for selection depend on the previously entered settings.

Index/Reset Position

Enter the distance between the first event after the set index/ reset marking and top dead
center. With the button Adjust, you can enter the measured firing angle for a given nominal
value. The system calculates the difference from these values, which is added to or
subtracted from the index/reset position.

Pickup Sensitivity

Open the pick list and select the desired sensitivity level for the pickup. This setting
overwrites the value of the pre-trigger voltage if the latter was defined in the user-defined
pickup setup.

- High
The signal processing starts at low engine speeds. This setting can result in increased
susceptibility to failure.

- Medium
Default setting for MICT. This is a trade-off between start-up speed and sensitivity.

- Low
The signal processing does not start until high engine speeds are reached. This setting
can result in reduced susceptibility to failure.

Trigger/Cam No. of Triggers
Enter the number of events. The input Cam or Trigger is automatically selected by the MICT
and is governed by the selection of the pre-defined pickup settings.

User-defined
Staff authorized to access the Advanced Service level can, in addition to the standard
settings access, use a manual setup option by clicking on the button User-defined.

(8 Pickup Setup =)

Pickup Inputs

Input Type No. of Events Speed Active/Passive  Pre-Trigger [V]
Pickup Input 1 (Cam): [ SINGLE EVENT ~][o (camsHaFT  + ] [activehigh ~] 7.5 &
Pickup Input 2 (Reset): [ SINGLE EVENT BB (cRANKSHAFT v [passve  +] 1.5
Pickup Input 3 (igger): N ] 10 (cranksHAFT v [passve v 1.5

Lo ]
Trigger Disc Type, Default = NONE
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MOTORTECH

Type

You can select the type of events that will occur on this input for each pickup input. Type
and number of events are defined by the discs or ring gears used. If you decide not to
use a pickup input, select the entry None from the list. You can set the following types:
N

Disc, which causes a uniformly distributed number (N) of events (per rotation), e.g. a
ring gear with 160 teeth (N=160).

N+1

Disc type N with one additional event, e.g. a disc with 12 teeth and one additional tooth
for the index signal (N=12).

N+1 extended index range

Disc type N with an additional event, e.g. with one disc with 12 teeth and one additional
tooth for the index signal (N=12). The permitted range for the index signal is expanded
to 75 % of the tooth period. An incorrect direction of rotation of the engine cannot be
detected by this setting.

N-1

Disc type N, where one event is missing, e.g. a ring gear with 160 teeth on which one
tooth was removed (N=160). This missing event is used to determine the index signal
N-2

Disc type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on
which two teeth located next to each other were removed (N=60). This missing event is
used to determine the index signal.

N Magnets, Single Magnet

You will always use these two types together for a disc with magnets having opposite
polarity. A magnet with a fixed number of magnets (N), all of which are arranged at equal
distances on the disc, has a reverse polarity. Thus, the disc supplies two signals that
can be analyzed by a pickup.

Single Event

Disc that supplies a single event, e.g., a disc with one tooth or one magnet.

Number of Events

Enter the number of events that occur on the pickup if more than one event is expected.
For the types N+1 and N-1, enter the value for N and not the total number of events. With
the type N Magnets, the number of magnets with identical polarity must be entered.
The number of events must lie between 3 and 500. Additionally, it must be taken into
account that the sum of the frequencies at the pickup input does not exceed the limit of
10 kHz at the pre-set overspeed.

Speed

Select whether the respective pickup will pick up the signal off the camshaft or the
crankshaft.
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- Active/Passive
Select the pickup to be used from the pre-defined pick list:
Passive
passive pickup
Active (low)
active pickup with high level as quiescent level
Active (high)
active pickup with low level as quiescent level

—  Pre-Trigger
Enter a value between 0.1V and 7.5 V for each pickup to set the pickup sensitivity level.
Signals that fall short of the set voltage will not be analyzed. A low pre-set value
therefore results in a high sensitivity level, a high value results in a low sensitivity level.

& Pickup setup information
The respective latest setting in the area of the pre-defined or arbitrary
pickup settings is transferred to and displayed under Pickup Setup
Information.

Aux. pickup supply voltage
Enter the supply voltage with which the active pickup is to be operated. A value between 5 and
24 Vis possible.

Speed Settings
Enter the following settings in this section:

Ignition Release
Enter the release speed for the ignition at which the first ignition is to fire. The value shall
not exceed 1/7 of the nominal speed.

Security Speed

Enter the security speed (max. half the nominal speed). Below the value entered, the ignition
can be switched on and off as desired. If the ignition is deactivated during operation above
the set speed, the ignition cannot be immediately reactivated. Only when the ignition no
longer reads a speed, i.e., the engine has come to a standstill, can the ignition be
reactivated.

Nominal Speed
Enter the nominal speed at which your engine is to be operated. With engines that are to be
operated with variable speeds, the max. speed of the operating range must be entered.

Overspeed

Enter the speed at which the ignition is to be shut off as overspeed protection. With engines
that are to be operated with variable speeds, a speed above the operating range must be
entered.
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- Max. Power-on Speed
Enter the maximum permitted start speed at which the MIC4 starts sending ignition pulses.
Avalue of 6000 rpm is set as the default value: The MIC4 can be activated at the starter
speed and immediately send ignition pulses.
For a value of o rpm the MIC4 can only start sending ignition pulses once it has registered
that the engine is at a standstill.

8.11.6 Timing — Analog Inputs

= MOTORTECH

M unnamed.mic4* (MIC4x2.16) - MICT

Configuration Page
4 Engine
| Parameters
Cylinder Names
7 Ignition Outputs
" Ignition Coils
| Pickups
4 Timing
| Analog Inputs
4[] Schedule A
| General
7 Energy
4 [ ScheduleB
| General
| Energy
7 Miscellaneous
4 Inputs/Outputs
7 Alarms
7 Aso1
| Inputs
4 Miscellaneous
Communication

" Information

File Device Settings Document Tools Help

AT RS EBOrEE

Analog Inputs Base Settings
Analog Current Input

Lower Limit: 4.0
Upper Limit:  20.0
Failure Threshold: 3.2

Analog Voltage Input
Lower Limit: 0.0
Upper Limit: 5.0

Failure Threshold: 0.0

Aux Analog Input Supply Voltage

+| mA
< mA

< mA

Aux Analog Input Supply Voltage: 24.0(%] V

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000
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Auxiliary supply voltage

Check with the configuration of the analog inputs, that the set auxiliary
supply voltage corresponds to your application.
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Analog Inputs Base Settings
The ignition timing adjustment can be made using two analog input signals, which can be set
within the following limits:

— Analog current signal: 0-20 mA

- Analog voltage signal: 0-10 V

Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also,
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is
classified by the ignition controller as failure (e.g. wire break). The error value configured in the
schedule was set for the affected input. To reset the error state, a threshold will need to be
exceeded. This threshold value is calculated as follows:

Threshold to reset the error state >= 0.5 x (Lower Limit - Failure Threshold) + Failure Threshold

You set the analog input that will be used and which timing adjustment results from the analog
signal for the two possible schedules. Refer to the section Timing — Schedule A/B — General on
page 105.

Aux. Analog Input Supply Voltage

An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value
between 5V and 24 V.
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8.11.7 Timing — Schedule A/B - General

M unnamed.micd* (MIC4x2.16) - MICT (==
File Device Settings Document Tools Help
ogd &d 5 e : a7 =
AHF5S iR E0EEA ©
Configuration Page Schedule/A General Settings
4 [Engme 7] Enable Schedule Description:  Biogas
| Parameters
Cylinder Names Limits Cylinder Individual Timing Limits
| Ignition Outputs Min/Max Timing Point 1: 30.0 MinMax Indwvidual Limit 1: 2.0
e
. Pgm on Cofls Min/Max Timing Point 2: 5.0 Min/Max Indwvidual Limit 2: 2.0
ickups
4 Timir!g Base Timing [V] speed Curve
| Analog Input:
4 S": Zglnzu o 200 Number of Speed Points:
4 |} Schedule
R ‘ -
] General [¥] Potentiometer Function Speed [RPM] Trming [9 AdvRet
. hE;"Ifs; Clockwise: 5.0 10 0.0
i S
ool Counter Clockwise: 5.0 2 ® 50
eneral
| Energy [¥] Analog Current Input 3 1000 0.0
| Miscellaneous AtLower Limit (4.0mA): 1.0 4 0 0.0 RET v
4 Inputs/Outputs
| Alarms At Upper it (0.0m): 7.0 L o0 ==
7 Asot Default: 0.0 6 |o 0.0 RET %
| Inputs 7 0 0.0 RET v
4 Miscellaneous [¥] Analog Voltage Input 8 0 0.0 RET ;
] Communication AtLower Limit (0.0V): 0.0
| Information
AtUpper Limit (5.0 V): 7.0
Default: (0.0 RET v
@ COM3 IDMIC4x2.16 (1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Schedule A General Settings

The MIC4 offers two schedules for implementing the necessary settings for the timing of the
engine. The schedules A and B can be used for dual fuel operation, for example. The system
switches between the schedules via the input Schedule A/B. If only one schedule is configured,
the switch is ignored. The configuration options for schedule B are identical to those for set A.

— Enable Schedule
The settings are enabled or disabled by checking/unchecking the box. One schedule must
always be activated.

— Description
Enter a description for the schedule (e.g. natural gas for the setting for this type of gas).

Limits
Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs

will be limited to this range relative to the respective top dead center of the pertinent cylinder.
The global timing can then not be shifted beyond this range by any adjustments.
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Base Timing
Enter the timing specified by the engine manufacturer. This point must be within the limits
entered and is a static portion of the global timing.

Potentiometer Function

The checkbox enables and disables the potentiometer function for manually adjusting the global
timing by the respective stops of the potentiometer set, depending on the direction of rotation. If
the potentiometer is subsequently disabled once again, the system will no longer access the
data during the following data transfer to the device and restart of the engine, and the device
will no longer use this data to calculate the global ignition timing.

Analog Current Input / Analog Voltage Input
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should
prefer the analog current input due to its lower sensitivity to faults.

Enter the values by which the adjustment is to be implemented for the corresponding input
signal. An error value can be entered for the signals if a failure threshold has been defined for
the corresponding input in the window Timing — Analog Inputs. If the signal is below the Failure
Threshold, the timing is offset by the error value. The offset remains until the signal again
exceeds the lower set limit.

Cylinder Individual Timing Limits

Enter the maximum possible cylinder individual offset. This setting limits, among other things,
the adjustment possibility in the window Cylinder Individual Offset. In addition the limits also
apply to the corresponding adjustment signals from all other sources, for example via the field
buses.

Speed Curve

The speed curve can be activated and disabled by mouse click and offsets the timing depending
on the speed. A max. of eight speed points are available. If you select a number of points from
the list, the corresponding number of fields is activated for input.

The first speed point is always set to o RPM. All other timing points are assigned with the value
by which the signal is to be offset when the respective speed is reached. For the last speed
point, the timing of the nominal speed should be entered. Please note that the speed points
must always be entered in ascending order.
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8.11.8 Timing — Schedule A/B - Energy
/g,' unnamed.mic4* (MIC4x2.16) - MICT (==

File Device Settings Document Tools Help

AHFES NN EO

Configuration Page Scheduic/AEnergy Settings
Pl < Start Phase
Engine
| Parameters Speed Limit: 600 RPM
Cylinder Names s A

Ignition Outputs Start phase ends if both lmits are exceeded.
| Ignition Coils

Pickups Spark Duration: 200 Tk

4 Timing Spark Intensity: 80 <1 mA
| Analog Inputs

4 Max. Breakdown Voltage: 42 kv
4 [ Schedule A
General Energy Limit: 300 Timl
| Energy, (imited by nominal speed)
4 [ ScheduleB
| General Homalopaistog
| Energy Spark Duration: 200 -
" Miscellaneous Spark Intensity: 70 S mA
4
Inpats/Outputz Max. Breakdon Voltage: 42 S
Alarms
1 ASO1 Energy Limit: 300 $oml
| Inputs
4 Miscellaneous Secondary diagnostics available if max. breakdown voltage is setin range 36 kV to 45 kV. Additionally its required that the
Communication i \, energy limit is set sufficiently high.
Information U Start phase: min. energy limit 264 m) for max. breakdown voltage 42 kV

Normal operation: min. energy limit 264 mJ for max. breakdown voltage 42 kv

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

You can make different energy settings for the start phase and normal operation.

Start Phase

Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit or both. If
you enter values for both criteria, both values must also be exceeded, so that the ignition
controller classifies the start phase as ended and sets the values for normal operation. If you
only want to use one criterion, set the other value to o. If you do not want to define any start-up
phase, set both values to o.

Enter values specific to your application for the Spark Duration, the Spark Intensity and the
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum
voltage expected during operation.

Normal Operation

If the criteria specified for the start phase are exceeded, the settings for normal operation are
used by the ignition controller. Make the energy settings the same as for the start phase.
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Energy Limit

You can use the field Energy Limit to limit the output energy made available by the ignition
controller. If the set output energy is no longer sufficient to reach the set energy values (spark
duration, spark intensity, max. breakdown voltage), the spark duration is reduced
correspondingly.

Required supply voltage for energy control

Depending on the output configuration and the energy settings, for a
correct energy control, a higher supply voltage than the minimum 10 V DC
sufficient for operation of the device can be necessary. If this is the case,
the required supply voltage is displayed in a notice in the window Timing —
Schedule A/B - Energy.

8.11.9 Timing — Miscellaneous
(M1 unnamed.micd* (MIC4x2.16) - MICT (=B

File Device Settings Document Tools Help

AHFHS i SSEBOEE

Configuration Page Miscellaneous
4 Engine Max Firing Angle Change Per Cyde
| Parameters Adv: 0.4
Cylinder Names s T
| Ignition Outputs
| Ignition Coils
Pickups
4 Timing

Analog Inputs
4 [} Schedule A
General
| Energy
4 [ ScheduleB
| General
| Energy
| Miscellaneous
4 Inputs/Outputs
Alarms
| ASO1L
Inputs
4 Miscellaneous
Communication

" Information

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000
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You can specify how fast the changes of the timing should be executed.

— Maximum Firing Angle Change Per Cycle

MOTORTECH

Specify the maximum degrees per cycle that the ignition timing may be shifted by for both
directions, i.e. between two firings of a cylinder. If the specified ignition timing adjustment
is larger than the given value, it is divided among several cycles.

8.11.10 Inputs/Outputs — Alarms

M unnamed.mic4* (MIC4x2.16) - MICT

c@lﬁ

Eile

Device

Settings  Document

4 Engine

4 Timing

a

Configuration Page

| Parameters

7 Ignition Outputs
" Ignition Coils
| Pickups

| Analog Inputs
1) Schedule A

1l Schedule B

7 Miscellaneous
4 Inputs/Outputs

| Alarms

| ASO1

| Inputs
4 Miscellaneous

" Information

Cylinder Names

| General
7 Energy

| General

| Energy

Communication

Tools Help

Alarms and GPO Settings
Alarms

1: speed > threshold (speed trip)
2: unused
3: unused
4: unused
5: unused
6: unused
7: unused
8: unused
9: unused
10: unused
11: unused
12: unused
13: unused
14: unused
15: unused
16: unused

GPO Settings

GPO1: |NORMALLY CLOSED v

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

AHF5S iR OO0EEA

Alarm 1

Function

Description:  speed trip

Function: [speed > threshold V]
Threshold: 18000 RPM
Hysteresis: 0.0 RPM
Delay: 0 ms

Settings
[C] Engine Shutdown
[7] Permanent - Keep output activated until alarm is acknowledged
[¥] Log Events
Outputs
[¥] ePo1

The MIC4 ignition controllers include a total of 16 configurable alarms that can be allocated to
the general purpose outputs.

— Description

You can enter any desired description for an alarm. The description is used for logging the
alarms that have occurred in the event list in the MICT.

— Function
The alarms can be used depending on the following functions:

-  Unused

- Speed above threshold / below threshold

Rev. 02/2020
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- Engine operating hours above threshold / below threshold

- Spark plug operating hours above threshold / below threshold

— Warning active

- Erroractive

- Temperature above threshold / below threshold

- Analog voltage input over threshold / under threshold

- Analog current input over threshold / under threshold

- Globalignition timing above the threshold / below the threshold

- Supply voltage above threshold / below threshold

- Min. spark duration above threshold / below threshold

- Misfire rate (primary, single output) over limit

- Misfire rate (primary, all outputs) over limit

- Misfires per second (primary, all outputs) above threshold

- Consecutive misfires (primary, single output) above threshold

- Misfire rate (secondary, individual output) above threshold

- Misfire rate (secondary, all outputs) above threshold

- Misfires per second (secondary, all outputs) above threshold

- Consecutive misfires (secondary, single output) over the limit
- Threshold

Input of desired threshold value.

— Hysteresis
Input of desired hysteresis value.

— Delay
Input of desired delay. The threshold value defined in the alarm must have been exceeded or
not reached for a longer period than the specified time for an alarm to be triggered. If a
corresponding value occurs for a shorter period of time, no alarm is triggered.

- Engine Shutdown
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered.
The shutdown causes an operational error. Therefore the checkbox should not be checked, if
the alarm Error active is selected.

— Permanent — Keep output activated until alarm is acknowledged
If this box is checked, the output remains permanently active until the alarm is
acknowledged. If the box is not checked, the output remains active only for as long as the
alarm is active.

- LogcEvents
If this box is checked, the event list records when the alarm occurred or when it was
acknowledged.
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— Outputs
Activate the checkbox GPOz1, so that the general purpose output is activated when the alarm
is triggered.

— GPO Settings
Configure the general purpose output as normally closed or normally open.

8.11.11 Inputs/Outputs — ASO1 (Auxiliary Synchronization Output)
/r,"r' unnamed.mic4* (MIC4x2.16) - MICT (=B

File Device Settings Document Tools Help

AHFHS RN EO

Configuration Page gso1
4 [Engine e N of Points: Angle Reference: ACTUAL ANGLES DEPENDING ON GLOBAL TIMING ~ |
o e it i 5
7 Ignition Outputs
| Ignition Cails Point Nr. Angle [7] Pulse Width [u:s] Point Nr. Angle [7] Puise Width [us]
Pickups 1 0.0 200 9 0, 0
4 Timing 2 0 10 10 0.0 0
Analog Inputs 3 0.0 0 1 0 0
4 [} Schedule A
General I o z 22 e 2
| Energy 5 0.0 10 13 0 0
4 [ ScheduleB 6 0.0 10 14 0.0 0
| General 7 oo 10 15 0.0 0
3 Energy 8 0.0 10 16 0 0
Miscellaneous
4 Inputs/Outputs
Alarms
| ASO1L
Inputs
4 Miscellaneous
Communication
1 Information

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

With the auxiliary synchronization output, freely definable impulses depending on the angle of
the crankshaft can be generated. For the output, the user defines whether the angle will be
absolute or based on the global timing. The output can generate between 1 and 16 impulses and
only be assigned to one system at a time. One example of the application of the ASO output for a
detonation controller can be found in section ASO: Auxiliary Synchronization Output on page 69.

— No. of Points
Select the number of impulses from the No. of Points list. Please note that the DetCon
detonation controller devices require a single impulse with 200 ps synchronous with the
first cylinder in the ignition sequence. You can get this setting via the button Configure for
DetConz/20.
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- Angle Reference
Select from the Angle Reference drop-down list whether the angle shall be based on the
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter
the trigger angle for each impulse and the length of the impulse in ps. This setting also
determines when ASO signals are generated. For this, also read the information box ASO
signals depending on the ignition release.

- Mode
Select the mode for the ASO signal.
In the default setting Trailing Rising Edge (default), the signal is low-active.

Level
A
t1 t2 t3
High —> —
. ) -~ A} -~
Low

°crank;haft

In the setting Trailing Falling Edge (inverted), the signal is high-active.

Level
t1 t2 t3
High ¢ 2 =2 ‘
* ) Y A 4 Y
Low =

°crankshaft

*) active edge marks the configured engine rotation angle

& Maximum impulse duration

Please note that the duration of the impulse can be entered as max. 300 ps.
Input of higher values will not be accepted by the system.
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& ASO signals depending on the ignition release
The setting in the drop down list Angle Reference determines when ASO
signals are generated:

NOTICE - Actual Angles Depending on Global Timing
ASO pulses are only transmitted if ignition is active, indicated by the
green status display Firing Active in the window Runtime Data —
Overview.

— Absolute Timing

ASO pulses are generated independently of the ignition release as soon
as the synchronization of the pickups is accomplished.
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8.11.12 Inputs/Outputs — Inputs

M! unnamed.mic4* (MIC4x2.16) - MICT (=B

File Device Settings Document Tools Help

AT, RN EO

Configuration Page Input Settings
4 Engine GPI Settings
| Parameters GPI1: [CAN reset (15 pulse), device reset (5 s puise) gl

Cylinder Names
7 Ignition Outputs
| Ignition Coils
Pickups
4 Timing
Analog Inputs
4 [} Schedule A
General
7 Energy
4 [ ScheduleB
| General
| Energy
" Miscellaneous
4 Inputs/Outputs
Alarms
| ASO1L
: Inputs
4 Miscellaneous
Communication

" Information

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Various functions can be selected for the general purpose input GPI1:

Disabled
The input GPI1 will not be used.

CAN reset (1 s pulse), device reset (5 s pulse)

This feature allows (e.g. a master control) to trigger a CAN reset and/or a device reset
externally using a high impulse. A high impulse of 1 second leads to a reset of the CAN driver
and a high impulse of 5 seconds leads to a device reset.

Warning acknowledge (¢ 3 s high), error and alarm acknowledge (> 3 s high), device reset
(> 15 s high)

This feature allows (e.g. a master control) warnings, errors, and alarms to be confirmed

and/or device reset to be triggered externally using a high impulse. If the high impulse is

shorter than 3 seconds, all warnings will be confirmed. If the high impulse is longer than

3 seconds, all errors and alarms will be confirmed. If the high level lasts for more than

15 seconds, this triggers a device reset.
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8.11.13 Miscellaneous — Communication

£ MOTORTECH

7 Energy
4 [ ScheduleB
| General
| Energy
7 Miscellaneous
4 Inputs/Outputs
7 Alarms
7 Aso1
| Inputs
4 Miscellaneous
; Communication

| Information

Modbus Settings

Modbus A«

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

M unnamed.mic4* (MIC4x2.16) - MICT =E|
File Device Settings Document Tools Help
= T © = 5 1 @ 71 [
SITEPAl N R [EE
Configuration Page Communication
4 Engine [V can
| Parameters CAN Mode CANopen Settings
Cylinder Names
S © ALL-IN-ONE (11939) CANopen Node ID: 30 <
Ignition Outputs =
1 gntion Cois b Boudeate:
| Pickups ®icitopen
4 Timing
" Analog Inputs [CIrsass
4 [ )] Schedule A RS485 Mode RS485 Settings
| General © Modbus =

CAN

Clicking on the CAN checkbox enables or disables the CAN interface on the device.
ALL-IN-ONE ()1939)/)1939/CANopen

Select the desired protocol, depending on whether you want to set the communication for
the ALL-IN-ONE or for another device. For example, for a connection to the PowerViews,

select CANopen.

J1939 Settings

The J1939 source address can be assigned between o and 253. Note that IDs cannot be
assigned more than once. The Address Filter can be used to set that broadcast PGNs are only
accepted from one or two specific source addresses you have entered. If the filter is
deactivated, the broadcast PGNs are accepted from all source addresses.
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CANopen Settings
The CANopen node ID can be assigned between 1 and 127. Note that IDs cannot be assigned
more than once.

Baudrate
Select the desired data transfer rate from the list. The baud rate can be defined between
50 kbit/s and 1 Mbit/s, the recommended value being 250 kbit/s.

RS485
Clicking on the field RS485 enables or disables the Modbus interface on the device.

Baudrate
Select the desired data transfer rate from the list. The Modbus baud rate can be defined
between 9,600 bit/s and 115,200 bit/s, the recommended value being 19,200 bit/s.

Parity
Define if a parity bit is used and if the parity is to be even or odd.

Stopbits
Determine if one or two stop bits are to be sent. Two stop bits can only be sent if no parity
has been selected.

Modbus Address
The Modbus address can be assigned between 1 and 247. Note that IDs cannot be assigned
more than once.

Mode
Define if the data are transferred in the ASCII or RTU mode.

& Setting the transfer rate

Please note that all devices connected with a bus must be set to the same
transfer rate.

& Information on protocols

Please contact your MOTORTECH contact person if you require more
information on the CANopen, J1939 and Modbus protocols.

NOTICE
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Rev. 02/2020



I 8 Settings via the MICT

8.11.14 Miscellaneous — Information
This configuration page can be viewed by all users, but changes can only be made with
authorization for the Service access level.

MOTORTECH

M unnamed.micd* (MIC4x2.16) - MICT

S

File Device Settings Document

Configuration Page
4 Engine
| Parameters
: Cylinder Names
7 Ignition Outputs
" Ignition Coils
] Pickups
4 Timing
" Analog Inputs
4 [} Schedule A
" General
| Energy
4 [ Schedule B
| General
| Energy
7 Miscellaneous
4 Inputs/Outputs
7 Alarms
7 Aso1
7 Inputs
4 Miscellaneous
" Communication

[ ] Information

Tools Help

1 QHSFES %N OOl

Information
Site and Module

Site Description:

Site Location:

Module Description:
Engine Type Description:

Service Contact

Contact Information (i.e. company, name, phone, e-mail):

@ COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Site and Module

In this section, enter information on the system and the module for which the configuration will

be used.

Service Contact

In this section, individual contact data can be saved that can be called up and displayed via

MICT.
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117




I 8 Settings via the MICT

8.12 Runtime Data
- Click on the symbol to open the window Runtime Data. The following sections
will give you an overview of the data you can view on the individual tabs.

You can print and record the runtime data. For this purpose, the following functions are at your
disposalin the toolbar in the window:

Symbol Function

Prints the runtime data.

Prints the runtime data to a PDF file.
Opens the print preview.

Starts the runtime data trace.

Stops the runtime data trace.

FONOK N X

Acknowledges the operating errors. If an operating error is acknowledged, all
alarms are also simultaneously acknowledged. The symbol is grayed out if no
acknowledged error is present.

Save runtime data locally

You should always save runtime data on the local computer and not on a
network drive or external storage device. Trace files can only be moved
freely once the recording is stopped.
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NOTICE

Rev. 02/2020

Displaying older runtime data files

Due to modifications on the message lists, recorded errors, warnings and
alarms of older runtime data files can be missing when they are displayed
in the current version of the MICT.

Runtime data files that were recorded under the following conditions are
affected:

—  MICT version prior to 1.31.x and

— Firmware version 0.14.4 or older

£ MOTORTECH
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8.12.1 Runtime Data — Overview
M! MICT - Runtime Data eSS

HEHA B

Overview | Timing | Igniton | BankA | States | Messagelog | Diagnostics | [

Speed Device State
Q Idle @ Configuration
@ Synchronizing Q© SelfTest

@ Firing Active
@ Firing Locked
@ Wait for Stop @ Start Phase

@ Wamning © Alarm
Q@ Error

Control

@ Firing Enabled
@ Schedule A
@ Schedule B
Q GPI1

Output
Q@ GPO1

Failure
@ Analog Current Input  (Q Analog Voltage Input

@ Ignition Output

Liminig Misfire Rate
Global Timing Point | EEIIN BTOC Primary e
Operating H Single Output - % - %
perating Hours
9 o

@ COM3 ID MIC4x1.08 (1.5.1 [0000a801]) Lifetime: 135:43:08.675

In this screen, you can find the following information:
- Speed Indicator (analog)

— Red pointer
Displays the current registered speed

— Yellow pointer
Displays the maximum registered speed since last starting the engine

— Green pointer
Display of set overspeed
- Speed Indicator (digital)
Digitally displays the current speed

- Global Timing Point
Digital indication of the current global timing
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— Operating Hours

— Spark Plugs
Indicates the current operating hours of the spark plugs

— Engine
Indication of current operating hours of the engine

— Device State
The status of the device is shown by the following status displays:

Device status Description

Idle The ignition is ready and waiting for pickup activity.
Synchronizing Pickup signals are being received and analyzed.

Firing Active The ignition is active.

Firing Locked Pickup signals are being received and are valid, ignition is

not released.

Wait for Stop Pickup signals are being received, the ignition fired above
the security speed, and the ignition release was retracted.
The engine must now come to a standstill.

Configuration The device is being configured.

Self Test The self test is running (refer to Self Test on page 80).

Start Phase The engine is in the configured start phase (refer to section
Timing — Schedule A/B - Energy on page 107).

Warning A warning has occurred (refer to Warnings on page 138).

Error An error has occurred (refer to Failure on page 139).

Alarm A configured alarm has occurred (refer to Alarms on
page 139).

— Control

- Firing Enabled
The green status display signals that the firing is active.

— Schedule A/B
The green status display shows which parameter settings are currently used.

- GPlh
The status display shows the status of the input signal.
—  Output

- GPO1
The general purpose output is switched on with the green status display.

Rev. 02/2020
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Failure

Analog Current Input

The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again
gray.

Analog Voltage Input

The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again
gray.

Ignition Output

The red status display signals a current misfire on at least one output. With a yellow
status display at least one misfire has occurred at one output since the last reset of the
counter.

Misfire Rate

The misfire rate is displayed for the primary side and secondary side. The misfire rate on the
secondary side is only displayed if the secondary side diagnosis is activated (refer to
section Engine — Ignition Coils on page 97).

Single Output
Displays the misfire rate of the output for which the most misfires were registered
during the last 32 cycles.

All Outputs
Displays the misfire rate for all the ignition outputs for the past 32 cycles.

The number of misfires per second are calculated by the MIC4 as follows:
2-stroke engine: Number of currently misfiring outputs x RPM / 60
4-stroke engine: Number of currently misfiring outputs x RPM / 60 / 2
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8.12.2 Runtime Data — Timing
( M MICT - Runtime Data B

DR

[ overview | Tming | Igniton | BankA [ States | Messagelog | Diagnosti [

Global Timing Point Calculation

Base Timing + [[EIJll] sT0C

Potentiometer Tming + [N ~ov  EENER -  —
Analog Current Input Timing + - RET - ma
Analog Voltage Input Timing + - ADV _ Vv -

Speed Curve Correction + - RET
Timing Correction + - RET

Global Timing Point | ISiSHI BTDC
Individual Timing

minimum | BTOC
Maximum - BTDC
Average - BTDC

@ COM3 ID MIC4x1.08 (1.5.1 [0000a801]) Lifetime: 135:44:30.676

In this view, the system displays all values and settings in the left hand section that influence
the timing. On the right, the current input values (e. g. potentiometer, analog current and
voltage input), leading to the displayed timing adjustment, are displayed numerically and in bar
charts. The value for the speed curve results from the curve progression set in the configuration.
Refer to the section Timing — Schedule A/B — General on page 105. The timing correction can be
implemented for the runtime. Please refer to the section Runtime Adjustments — Timing on

page 150.
In the lower range, the maximum, minimum and average of the cylinder individual offsets are
also displayed.
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8.12.3 Runtime Data — Ignition
( M MICT - Runtime Data B

L 2E: SORURC

[ Overview | Timing | loniton | BankA | States | Messagelog | Diagnosti I =

L)

Output Cylinder Seco“iﬁg“\}z}z‘ge o Misfire

S A A B
2 B8 — - 1 10
A3 3-5'1::']'3::'41)'10
R e e A A B
ol B
« v 1 5 o 1 " 1@
R P e D S
o = g % A®
Coil Data Version: 1

@ COM3 ID MIC4x1.08 (1.5.1 [0000a801]) Lifetime: 135:45:43.676

The following information is provided:

- Column: Output
Designation of the output

- Column: Cylinder
If cylinder names are assigned, these are displayed.

- Column: Estimated Secondary Voltage [kV]
Secondary voltage determined by the ignition controller of the respective output.
The secondary voltage is used to determine deviations between the individual outputs.
These indicate a possible problem at this output (e. g. problems in the area of the spark plug
or the cylinder).
If you have set the ignition coils (refer to Engine — Ignition Coils on page 97) for which a
secondary voltage estimate does not seem possible "---" appears.
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—  Column: Misfire
The red status display signals a current misfire at the respective output. With a yellow status
display at least one misfire has occurred at the respective output since the last reset of the
counter.

The coil data version configured in the MIC4 is displayed under the ignition runtime data.

8.12.4 Runtime Data — Bank A and B
M! MICT - Runtime Data eSS
DA G
Overview | Timing [ Ioniton | BankA | states [ Messagelog [ Dagnostis | [

Misfire
" Angle Min. Spark ~ Energy -
Output Cylinder [ Crank] Duration [ps] Output [mJ] Primary Secondary

open short Rate [%] open short Rate [%]

At I HE v EE El o ol o o
2 s I EE o o i 0 o HA
A SHE~ il Bl o ol o o
o~ i BN o ol o o HH
x o v S B o o W o o W
A6 'IEE oI B o ol o © Il
o o EE o ol o o
as o IEHESE v IEEEEE] ES 0 O HH © © HH

Show Firing Angles: @ Relative () Absolute

@ COM3 ID MIC4x1.08 (1.5.1 [0000a801]) Lifetime: 138:25:12.413

The following information is provided:

—  Column: Output
Designation of the output

—  Column: Cylinder
If cylinder names are assigned, these are displayed.

— Column: Angle
Current output firing angle
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—  Column: Min. Spark Duration
Minimum spark duration of the outputs

—  Column: Energy Output
Current energy release of the output

- Columns: Misfire
Status display for the different types of misfires (primary, secondary, open, short circuit). In
case of misfire, the respective status display turns red, otherwise it is gray. With a yellow
status display misfires have occurred since the last reset of the counter.
If you hold the pointer over the status display, an overview of the misfire counter of the
respective output is displayed for all types of misfires. A maximum up to 255 is counted per
type of misfire. The counter manually resets using the menu item Device-» Send command ->
Reset misfire counters. When starting the engine and starting the self test the counters are
automatically reset.

You have the following options:

— Relative/Absolute
Select via the option, whether the firing angle should be displayed absolute or relative.
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8.12.5 Runtime Data — States
M MICT - Runtime Data @E‘g
FEAY B

Overview | Timing | Igniton | BankA | States | Messagelog | Diagnostics | [

Operating Hours  Time Status Message
135:51:17.286  2015-12-09 13:39:48 PUL: Missing index.
135:51:17.286  2015-12-09 13:39:48 PU2: Operational error.
135:51:17.286  2015-12-09 13:39:48 PU2: Missing index.

@ COM3 ID MIC4x1.08 (1.5.1 [0000a801]) Lifetime: 135:51:51.679

Status messages are listed in the States view.
The following information is provided:

— Operating Hours
Operating hours counter reading at the time of message

- Time
Date and time of the message (see following information box)

— Status Message
Message text
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Date and time of ignition controller

The date and time can be individually configured for each ignition controller
and saved in the device. The device does not adjust automatically for
daylight savings time. Hence, deviations may occur between the device
time and the time on the computer used to access the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device - Set date and time.

Status messages are displayed in black if they are current. If a status is reset, the status
message is displayed gray for 10 seconds before it is deleted from the list.

The following status messages can be displayed:

Status message

Alarm shutdown caused by alarm
number.

Analog current input failure
(current: x mA, failure threshold:
y mA, failure reset threshold:

z mA).

Analog voltage input failure
(voltage: x V, failure threshold:
y V, failure reset threshold: z V).

Aux analog input supply voltage
failure (voltage: u V, desired
voltage: v V, failure threshold: x V,
failure reset threshold: y V).

Aux pickup supply voltage failure
(voltage: u V, desired voltage: v V,
failure threshold: x V, failure reset
threshold: y V).

Configuration data checksum
error. Using default configuration.

128

Description

The engine was shut down by an alarm, as the configured
limit was exceeded or not reached. You can view the
alarm number in the configuration (see Inputs/Outputs —
Alarms on page 109).

Failure threshold set for analog current input was
undershot (see Timing — Analog Inputs on page 103).

The following values were obtained: Current: x mA, failure
threshold: y mA, threshold for failure reset: z mA.

Failure threshold set for analog voltage input was
undershot (see Timing — Analog Inputs on page 103).
The following values were obtained: Voltage: x V, failure
threshold: y V, threshold for failure reset: z V.

Error in auxiliary supply voltage of analog inputs (see
Timing — Analog Inputs on page 103). The following
values were obtained: Voltage: u V, expected voltage: v V,
failure threshold: x V, threshold for failure reset: y V

Error in auxiliary supply voltage of pickup (see Engine —
Pickups on page 99). The following values were obtained:
Voltage: u V, expected voltage: v V, failure threshold: x V,
threshold for failure reset: y V

The checksum of the configuration data is faulty. The
default configuration is used. This message may appear
during an upgrade/downgrade. Check your configuration
data and the MICT version being used. Then download the
configuration to the device once again.
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Status message

Configuration invalid. Using
previous configuration.

Current sensor of output bank
name failed.

Cylinder individual timing limited
to range timing 1 .. timing 2

Device started after supply
voltage failure.

General error number.

MOTORTECH

Description

The configuration is invalid. The previous configuration is
used. This message may appear during an upgrade/
downgrade. Check your configuration data and the MICT
version being used. Then download the configuration to
the device once again.

The current sensor of output bank name failed. Restart
the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.

The cylinder-individual offset has reached the set limit
(Timing 1 ... Timing 2 (see Timing — Schedule A/B —
General on page 105).

The device was started after a failure of the supply
voltage. Please check the power supply of the device
where applicable.

General error number. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

Global timing x° crankshaft limited The global timing (x° crankshafft) is located outside the

to range y° crankshaft .. z°
crankshaft.

Incompatible coil parameters
received, secondary voltage
diagnostics disabled.

Output board identification failed
due to a checksum error.

Output board identification failed
due to incompatible hardware.

Output board identification failed
due to missing data.

Rev. 02/2020

configured limits (y° crankshaft .. z° crankshaft; see
Timing — Schedule A/B — General on page 105).

Incompatible coil parameters received. The secondary
voltage diagnostics have been disabled. This message
may appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

The identification of the output board failed due to a
checksum error. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
incompatible hardware. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

The identification of the output board failed due to
missing data. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.
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Status message

Output board identification failed
due to unknown error number.

Output board identification failed
due to unknown hardware.

Pickup configuration invalid.

Power failure detected on output
Anumber/Bnumber.

Power output (x W) exceeded error
threshold limit (y W) at a supply
voltage of z V.

Power output (x W) exceeded limit
(v W) at a supply voltage of z V.

The power output (x W) exceeded
permanent limit (y W) at a supply
voltage of z V.

PUnumber: Faulty index.
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Description

The identification of the output board failed due to
unknown error number. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

The identification of the output board failed due to
unknown hardware. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

Power supply fault in output board at output Anumber/
Bnumber was detected. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

The power output (x W) exceeded failure threshold (y W) at
a supply voltage of z V. Increase the supply voltage and
check the energy settings (see Timing — Schedule A/B —
Energy on page 107).

The power output (x W) exceeded warning threshold limit
(v W) for longer than two minutes at a supply voltage of

z V. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on

page 107).

The power output (x W) exceeded warning threshold limit
(v W) for longer than three minutes at a supply voltage of
z V. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on

page 107).

The pickup PUnumber has an error in index. Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 99). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 168.
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Status message

PUnumber: Faulty Signal. Signal
period (x, events counted ) is too

£ MOTORTECH

Description

The pickup (PUnumber) is supplying a faulty signal.
Signal period (x, events counted y) is too small compared

small compared to previous signal to previous signal period (2). Check the pickups and the

period (2).

PUnumber: Index mark missing.

PUnumber: Missing index.

PUnumber: Missing Signal. Signal
period (x, events counted y) is too
great compared to previous signal
period (2).

PUnumber: Missing Signal. Signal
timeout occurred (events counted
X).

PUnumber: No index mark found.

PUnumber: No signal.

Rev. 02/2020

corresponding configuration (see Engine — Pickups on
page 99). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 168.

Index mark missing for pickup (PUnumber). Check the
pickups and the corresponding configuration (see Engine
- Pickups on page 99). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 168.

Index missing for pickup (PUnumber). Check the pickups
and the corresponding configuration (see Engine —
Pickups on page 99). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 168.

Signal missing for pickup (PUnumber). Signal period (x,
events counted y) is too large compared to previous
signal period (2). Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 99). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 168.

Signal missing for pickup (PUnumber). Timeout occurred
(events counted until timeout x). Check the pickups and
the corresponding configuration (see Engine — Pickups on
page 99). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 168.

Could not find index mark for pickup (PUnumber). Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 99). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 168.

The pickup (PUnumber) is not supplying a signal. Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 99). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 168.

131



I 8 Settings via the MICT

Status message

PUnumber: Number of events (x)
counted on pickup input

Description

For the pickup (PUnumber) the number of events (x)
counted on pickup input number does not the match the

PUnumber does not the match the expected value (y). Check the pickups and the

expected value ().

PUnumber: Operational error.

PUnumber: Polarity detection
failed.

PUnumber: Synchronization
problem.

PUnumber: Wrong pickup signal
polarity on pickup input
PUnumber detected. Reversing
polarity internally.

Self test aborted because pickup

signals have been detected on
pickup input PUnumber.

Speed (x RPM) exceeded
overspeed limit (y RPM) at trigger
signal number.

Temperature of device (x °C)
exceeded error threshold limit

v°0.
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corresponding configuration (see Engine — Pickups on
page 99). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 168.

An operational error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 99). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 168.

Polarity detection failed for pickup (PUnumber). Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 99). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 168.

A synchronization error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 99). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 168.

Wrong polarity of pickup (PUnumber) detected at pickup
input PUnumber. Reversing polarity internally. No
additional action required.

Self test aborted because pickup signals have been
detected on pickup input PUnumber. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 80).

Potential causes:

— Interference coupling on pickup signal
— Engine was started

The speed (x RPM) exceeded overspeed limit (y RPM) at
trigger signal number (see Engine — Pickups on page 99).
The reason for this may also be an interference coupling
on the trigger signal.

The temperature of the device (x °C) exceeded failure
threshold (y °C). Ensure that there is sufficient air
circulation and/or cooling.
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Stat!

message

Temperature of device (x °C)
exceeded limit (y °C).

Temperature of device (x °C)

exceeded permanent limit (y °C).

Temperature sensor failed.

MOTORTECH

The temperature of the device (x °C) exceeded warning
threshold limit (y °C) for more than two minutes. Ensure
that there is sufficient air circulation and/or cooling.

The temperature of the device (x °C) exceeded warning

threshold limit (y °C) for more than ten minutes. Ensure

that there is sufficient air circulation and/or cooling.

The temperature sensor has failed. Restart the ignition
controller. If the error occurs again after restarting the

device, please contact MOTORTECH.

8.12.6 Runtime Data — Message Log

(M MICT - Runtime Data [E=E
sd 4 &4 o 3
1 3= JORUIR"
[ overview | Tming | Ionition | BankA [ States | Messagelog | Diagnosti I

Operating Hours
131:20:14.217

132:17:56.966
132:17:56.971

132:36:03.768
132:36:03.769

132:44:17.876
132:44:17.882
133:51:43.495

135:39:53.392
135:41:39.217

135:51:17.286

Time

2015-12-08
2015-12-08
2015-12-08
2015-12-08
2015-12-08
2015-12-08
2015-12-08
2015-12-08
2015-12-08
2015-12-08
2015-12-08
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09
2015-12-09

14:33:54
14:33:54
14:36:05
14:36:05
14:39:23
14:39:23
15:31:37
15:31:37
15:32:31
15:32:31
15:46:49
10:21:35
10:21:35
10:21:36
10:24:28
10:24:32
10:24:32
10:24:33
10:32:47
10:32:47
11:40:13
11:40:21
13:28:24
13:28:24
13:30:10
13:30:10
13:35:20
13:35:20
13:36:09
13:39:48
13:39:48

Category Message

Info
Alarm
Info
Alarm
Info
Alarm
Info
Alarm
Info
Alarm
Info
Info
Info
Info
Info
Info
Info
Info
Info
Alarm
Info
Info
Info
Alarm
Info
Alarm
Error
Error
Info
Error
Error

Configuration changed.

All alarms reset.

Configuration changed.

All alarms reset.

Configuration changed.

All alarms reset.

Configuration changed.

All alarms reset.

Configuration changed.

All alarms reset.

Device switched off.

Device (firmware 1.0.1.21538) started at a supply voltage of
J1939 on interface CAN1 changed state to "Enter”.

J1939 on interface CANL changed state to "Start succeeded
Device switched off.

Device (firmware 1.0.1.21538) started at a supply voltage of
11939 on interface CANL changed state to "Enter".

J1939 on interface CANL changed state to "Start succeeded
Configuration changed.

All alarms reset.

Self test started.

Self test stopped.

Configuration changed.

All alarms reset.

Configuration changed.

All alarms reset.

Cycle signal was missing, so that more trigger were counter
Operational error caused by pickup signals. PUL = 0x00000C
Operational error acknowledged. =
Cycle signal was missing, so that more trigger were counte
Operational error caused by pickup signals. PUL = 0x00200C j‘

<

(T

| »

[¥] Automatic scrolling

Acknowledge Alarms

@ COM3 ID MIC4x1.08 (1.5.1 [0000a801]) Lifetime: 135:52:31.679

In the view Message Log, information, warnings, errors and alarms are listed.
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Information, warnings and errors are specified by the ignition controller, while alarms can be
freely configured using the MICT. Refer to the section Inputs/Outputs — Alarms on page 109.

Errors and appropriately configured alarms shut down the engine.
The following information is provided:

— Operating Hours
Operating hours counter reading at the time of message

- Time
Date and time of the message (see following information box)

- Category
Type of message (information, warning, error, alarm)

— Message
Message text; you can find more information on the message text in the following sections.

You have the following options:

— Automatic scrolling
If this box is checked, the system automatically displays the last list entry until a new event
occurs.

— Acknowledge Alarms
With this button, you can reset triggered alarms if they are no longer active. An alarm can
only be acknowledged if the checkbox Permanent — Keep output activated until alarm is
acknowledged in the alarm configuration is activated.

& Date and time of ignition controller

The date and time can be individually configured for each ignition controller

and saved in the device. The device does not adjust automatically for
daylight savings time. Hence, deviations may occur between the device
time and the time on the computer used to access the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device -» Set date and time.
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) Acknowledging an operating error
While the engine is in standstill, there are the following options for
acknowledging operating errors:
NOTICE — via Device -> Send command -»> Acknowledge operational error in the
MICT

— Restart / Reset

— Hold button PB on the controller longer than three seconds

& Acknowledging warnings
You can acknowledge a warning by briefly pressing the pushbutton PB on
the controller.
NOTICE
& Displaying older runtime data files
Due to modifications on the message lists, recorded errors, warnings and
alarms of older runtime data files can be missing when they are displayed
SRETICE in the current version of the MICT.

Runtime data files that were recorded under the following conditions are
affected:

—  MICT version prior to 1.31.x and

— Firmware version 0.14.4 or older

8.12.6.1 Information

Information Description

Access control disabled. The Access control was disabled (see Access Control for
MIC4 on page 84).

Access control enabled. The Access control was enabled (see Access Control for
MIC4 on page 84).

All access control PINs reset. All PINs for access control were reset (see Access Control
for MIC4 on page 84).

CAN interface CANnumber entered bus The CAN interface CANnumber has entered Bus off state
off state. (see Runtime Data - Diagnostics on page 143).
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Information

CAN interface CANnumber left bus off
state.

CAN reset requested by GPInumber.

CANopen on interface CANnumber
changed state to "name".

Configuration changed.

Date and time set.

Device (firmware
number.number.number.number)
started at a supply voltage of x V.

Device reset requested by GPlnumber
failed because pickup signals have
been detected.

Device switched off.
Engine operating hours set to x h.

Failed to change PIN of access control
level "number".

Failed to disable access control.
Failed to enable access control.

Failed to reset all access control PINs.

Firing disabled (Start/Stop In: value,
CAN: value, RS485: value)
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Description

The CAN interface CANnumber has left the Bus off state
(see Runtime Data — Diagnostics on page 143).

A CAN reset was requested via general purpose input
GPlnumber (see Inputs/Outputs — Inputs on page 114).

The CANopen at interface CANnumber has changed state
to "name" (state of NMT State Machine according to CiA
DS 301).

The Configuration of device was changed (via the MICT or
via fieldbus).

The date and the time have been set.

The device (firmware number.number.number.number)
was started with a supply voltage of x V.

The device reset requested by GPInumber failed because
pickup signals have been detected (see Inputs/Outputs —
Inputs on page 114).

The device was switched off.
The engine operating hours set to x h.

Failed to change PIN of access control level "number" (see
Access Control for MIC4 on page 84).

The access control could not be disabled (see Access
Control for MIC4 on page 84).

The access control could not be enabled (see Access
Control for MIC4 on page 84).

Failed to reset all PINs for access control (see Access
Control for MIC4 on page 84).

The firing is disabled, because at least one of the inputs
(start/stop input, CAN interface, RS485 interface) used for
the firing release is disabled. The inputs can have the
following values:

— enabled: Firing enabled
— disabled: Firing disabled

- n/a: not used
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Information

Firing enabled (Start/Stop In: value,
CAN: value, RS485: value)

J1939 on interface CANnumber
changed state to "name".

One or more messages are lost due to
exhausted memory pool or message
queue overrun.

Operational error acknowledged.

PIN of access control level "number"
changed.

Self test denied because no outputs
are configured.

Self test started.
Self test stopped.
Spark plug operating hours set to x h.

Speed (x RPM) exceeded maximum
allowed speed (yRPM) at power-on.
Waiting for engine stop.

MOTORTECH

Description

The firing is enabled, because all inputs (start/stop input,
CAN interface, RS48s5 interface) used for the firing release
are enabled. The inputs can have the following values:

— enabled: Firing enabled
— disabled: Firing disabled
- n/a: not used

J1939 on interface CANnumber changed state to "name".
Following statuses are possible:

- Enter/Start succeeded
The CAN mode /1939 or ALL-IN-ONE (J1939) was
started.

- Start failed
Initialization failed.
- Stop
Assignment of the Source Address was unsuccessful.
A different source address needs to be set in the
configuration (see Miscellaneous — Communication
on page 115).
- Leave
Left CAN mode /1939 or ALL-IN-ONE (J1939).
One or more messages were lost because there was
insufficient storage space or too many messages were
queued.

Operating errors are acknowledged.

PIN of access control level "number" changed (see Access
Control for MIC4 on page 84).

The self test could not be carried out because no outputs
are configured (see Self Test on page 80).

The self test was started (see Self Test on page 80).
The self test was stopped (see Self Test on page 80).
The spark plug operating hours were set to x h.

Speed (x RPM) has exceeded the maximum speed (y RPM)
during operation. The ignition controller is waiting for the
engine to stop.

Wrong pickup signal polarity on pickup Wrong pickup polarity detected at pickup input

input PUnumber detected. Reversing
polarity internally.

Rev. 02/2020

PUnumber. Reversing polarity internally.
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8.12.6.2 Warnings

Contrary to errors, warnings do not result in the engine being shut down.

Warning

Configuration data checksum
error. Using default configuration.

Configuration invalid. Using
previous configuration.

Disable secondary diagnostic due
to output Anumber/Bnumber.

General warning number.

Incompatible coil parameters
received, secondary voltage
diagnostics disabled.

Invalid coil data received.

Pickup configuration invalid.

Power output (x W) exceeded limit
(v W) at a supply voltage of z V.
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Description

The checksum of the configuration data is faulty. The
default configuration is used. This message may appear
during an upgrade/downgrade of the firmware. Check
your configuration data and the MICT version being used.
Then download the configuration to the device once
again.

The configuration is invalid. The previous configuration is
used. This message may appear during an upgrade/
downgrade. Check your configuration data and the MICT
version being used. Then download the configuration to
the device once again.

Secondary diagnosis disabled due to output Anumber/
Bnumber shut off. Check the ignition coil and wiring at
the corresponding output.

General warning number. An undefined warning has
occurred. If this occurs repeatedly, please contact
MOTORTECH.

Incompatible coil parameters received. The secondary
voltage diagnostics have been disabled. This message
may appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

Invalid coil data received. This message may appear
during an upgrade/downgrade. Check your configuration
data and the MICT version being used. Then download the
configuration to the device once again.

The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

The power output (x W) exceeded warning threshold limit
(y W) for longer than two minutes at a supply voltage of
zV.

Rev. 02/2020



I 8 Settings via the MICT

Warning

Speed (x RPM) exceeded
overspeed limit (y RPM). Previous
speed was z RPM.

Temperature of device (x °C)
exceeded limit (y °C)

8.12.6.3 Alarms

MOTORTECH

Description

Speed (x RPM) exceeded overspeed limit (y RPM).
Previous speed was z RPM (see Engine — Pickups on page
99). The reason for this may also be an interference
coupling on the trigger signal.

The temperature of the device (x °C) exceeded warning
threshold limit (y °C) for more than two minutes. Ensure
that there is sufficient air circulation and/or cooling.

Alarms can be defined in the configuration. When doing so, each alarm is assigned a number
(see Inputs/Outputs — Alarms on page 109).

Alarm

Alarm number ‘"description"
acknowledged.

Alarm number ‘"description"

triggered.

All alarms reset.

8.12.6.4 Failure

Description

The alarm number "description" was acknowledged.

The alarm number "description" was triggered.

All alarms reset.

All system or operating errors cause the engine to be shut down.

Error
Alarm shutdown caused by alarm
number.

Assertion failed (x).

Critical error x (y).

Current sensor of output bank
name failed.

Rev. 02/2020

Description

The engine was shut down by alarm number. This
function was defined in the configuration (see Inputs/
Outputs — Alarms on page 109).

An assertion was not adhered to (x). For example, an
assumption for a value was not fulfilled in the firmware. If
the error occurs again after restarting the device, please
contact MOTORTECH.

Critical error x (y). If the error occurs again after restarting
the device, please contact MOTORTECH.

The current sensor of output bank name failed. Restart
the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.
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Error Description

Cycle signal was missing, so more Cycle signal was missing, so more trigger signals were

trigger signals were counted than  counted than available per cycle. Check the pickups and

available per cycle. the corresponding configuration (see Engine — Pickups on
page 99). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 168.

Device started after supply voltage The device was started after a failure of the supply
failure. voltage. Please check the power supply of the device
where applicable.

General error number. General error number. An undefined error has occurred.
Restart the ignition controller. If the error occurs again
after restarting the device, please contact MOTORTECH.

General error in pickup General error in pickup pre-processing on pickup input
pre-processing on pickup input PUnumber. Check the pickups and the corresponding
PUnumber. configuration (see Engine — Pickups on page 99).

Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 168.

Number of trigger signals Number of trigger signals (number) counted does not
(number) counted does not match  match the configured value. Check the pickups and the
the configured value. corresponding configuration (see Engine — Pickups on

page 99). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 168.

Operational error caused by Operational error caused by pickup signals. Pickup
pickup signals. PU1 =x, PU2 =y, PU1 =x, Pickup PU2 =y, Pickup PU3 =z

PU3=2. For information on the numbers shown, please consult

the documentation on the pickup status bits on the
storage device enclosed with the ignition controller. You
can open the file via the menu: Documentation -> More
information.

Check the pickups and the corresponding configuration
(see Engine — Pickups on page 99). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 168.

Output board identification failed  The identification of the output board failed due to a

due to a checksum error. checksum error. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.
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Error

Output board identification failed
due to incompatible hardware.

Output board identification failed
due to missing data.

Output board identification failed
due to unknown error number.

Output board identification failed
due to unknown hardware.

Power failure detected on output
Anumber/Bnumber.

Power output (x W) exceeded error
threshold limit (y W) at a supply
voltage of z V.

Power output (x W) exceeded
permanent limit (y W) at a supply
voltage of z V.

Self test aborted because pickup
signals have been detected on
pickup input PUnumber.

Rev. 02/2020

MOTORTECH

Description

The identification of the output board failed due to
incompatible hardware. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

The identification of the output board failed due to
missing data. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
unknown error number. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

The identification of the output board failed due to
unknown hardware. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

Power supply fault in output board caused by output
Anumber/Bnumber was detected. Restart the ignition
controller. If the error occurs again after restarting the
device, please contact MOTORTECH.

The power output (x W) exceeded failure threshold (y W)
at a supply voltage of z V.

The power output (x W) exceeded warning threshold limit
(y W) for longer than three minutes at a supply voltage of
zV.

Self test aborted because pickup signals have been
detected on pickup input PUnumber. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 80).

Potential causes:

— Interference coupling on pickup signal

— Engine was started
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Error

Speed (x RPM) exceeded
overspeed limit (y RPM) at trigger
signal number.

Supply voltage failure.

Temperature of controller board
(x°C) exceeded limit (y °C).

Temperature of device (x °C)
exceeded error threshold limit
°o.

Temperature of device (x °C)
exceeded permanent limit (y °C).

Description

The speed (x RPM) exceeded overspeed limit (y RPM) at
trigger signal number (see Engine — Pickups on page 99).
The reason for this may also be an interference coupling
on the trigger signal.

Supply voltage failure. Please check the power supply of
the device where applicable.

The temperature of controller board (x °C) exceeded limit
(y° ©). Ensure that there is sufficient air circulation and/or
cooling.

The temperature of the device (x °C) exceeded failure
threshold (y °C). Ensure that there is sufficient air
circulation and/or cooling.

The temperature of the device (x °C) exceeded warning
threshold limit (y°C) for more than two minutes. Ensure
that there is sufficient air circulation and/or cooling.

Temperature of output board (x°C) The temperature of output board (x °C) exceeded limit

exceeded limit (y °C).

Temperature sensor of controller
board failed.

Temperature sensor of output
board failed.

Trigger period (x, triggers counted
y) is not in acceptable range
compared to previous trigger
period (2).

Trigger signal missing. Current
trigger period (triggers counted x)
is out of the specified range
related to the previous trigger
period.
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(y °C). Ensure that there is sufficient air circulation and/or
cooling.

The temperature sensor of controller board failed. Restart
the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.

The temperature sensor of output board failed. Restart
the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.

The trigger period (x, triggers counted y) is not in
acceptable range compared to previous trigger period (2).
Check the pickups and the corresponding configuration
(see Engine - Pickups on page 99). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 168.

The trigger signal is missing. Current trigger period
(triggers counted x) is out of the specified range
compared to the previous trigger period. Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 99). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 168.
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8.12.7 Runtime Data — Diagnostics

M MICT - Runtime Data =
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Supply Voltage [V]

e
T T T T & T T
0 10 20 30 40

Pickup Input 1 Pre-Trigger [V]
e
0 2 4 6 8 10

Pickup Input 2 Pre-Trigger [V]
I

T
° 2 4 6 8 10

Pickup Input 3 Pre-Trigger [V]
e

- T 1T T T 1 171
0 2 4 6 8 10

Aux Pickup Supply Voltage [V]
i e ——

r—r 1. r 1 r 71711

0 5 10 15 20 25

Aux Analog Input Supply Voltage [V]

- T T T 1T T 1T 71
0 5 10 15 20 25

Output Board

Power Output [W] -

@ COM3 ID MIC4x1.08 (1.5.1 [0000a801]) Lifetime: 135:54:54.680

The following information is provided:
— CAN State

MOTORTECH

The status display indicates the current error handling status of the device for the CAN bus

communication:

— Error Active

The device is in normal status of the bus communication. If an error occurs in the

communication, the device sends an active Error Flag.

— Error Passive

After a defined number of errors in the bus communication, the device changes to the
status Passive Error. If another error occurs, the device sends a passive Error Flag.

— Bus Off

The device is disconnected from the CAN bus due to error accumulations in the bus

communication.
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- Controller Board
— Supply Voltage
Current voltage supply of the controller board.

— Pickup Input Pre-Trigger Voltage
Current pre-trigger voltage for the pickup inputs (refer to Engine — Pickups on page 99).
During operation the pre-trigger voltage for passive pickups is increased depending on
the speed, so that the ignition controller is less prone to interferences.

— Aux. Pickup Supply Voltage
Current auxiliary supply voltage of the pickups (refer to Engine — Pickups on page 99)

— Aux. Analog Input Supply Voltage
Current auxiliary supply voltage of the analog inputs (refer to Timing — Analog Inputs on

page 103)

- Output Board

— Power Output
Current output of the output board
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8.12.8 Runtime Data — Temperatures

M MICT - Runtime Data =
of ©d &4 o 7Yy
i 3. =) - SORUEC)
Overview | Timing | Ignition | BankA [ States | Messagelog | Diagnosti i

Controller Board

Current Temp [°C] - I
T T T T T

50 0 50 100 150

Min Temp [°C] - |
S e e e e e |
50 0 50 100 150

MaxTemp[’C]- I
50 0 S0 100 150

Output Board
CurrentTemp[“C]- I

50 0 50 100 150

Min Temp [°C] - E—
I e e I |
50 0 50 100 150

Max Temp [°C] - |
T T T T T T

50 0 50 100 150

@ COM3 ID MIC4x1.08 (1.5.1 [0000a801]) Lifetime: 135:58:12.682

In the window you receive an overview of the temperatures of the controller board and the
output board. The maximum and minimum values are reset at each new start of the ignition
controller.

The following information is provided:
— Controller Board

—  Current Temp.
Current temperature of the controller board

- Min. Temp.
Minimum measured temperature of the controller board

- Max. Temp.
Maximum measured temperature of the controller board
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— Output Board

—  Current Temp.
Current temperature of the output board

- Min. Temp.
Minimum temperature measured on the output board

- Max. Temp.
Maximum temperature measured on the output board

8.12.9 Runtime Data — Information
( M1 MICT - Runtime Data (==

FEHA B

[ overview | Timing [ Ionition | BankA [ states | Messagelog | ics |

Device

Device ID MIC4 4x1.08 (1.5.1 [0000a801])
Arrangement Number 421.08.C000-000-AA-4

Serial Number 01011134

Bootloader Version 0.26.2.20138

Firmware Version 1.0.1.21538

Operating Hours 135:59:51.592

Controller Board

Serial Number CPU00002951B

Hardware Version 1.4.0.19856

Output Board

Serial Number 1/0000029518

Hardware Version 1.3.0.12975

Clock

Date and Time Wednesday, December 9, 2015 12:40:31 PM UTC

@ COM3 ID MIC4 4x1.08 (1.5.1 [0000a801]) Lifetime: 135:59:51.592

In this view, you can find an overview of the device and version data. If problems arise, you can
print the current runtime data and send them to the MOTORTECH Service Department by fax or as
a PDF file by email. For fast support, we will then immediately have all required information.
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8.13 Log
I Click on the symbol to open the window Log. This window is only available to
u users with authorizations starting at the access level Advanced Service.

(9 MCT - Log ol
[¥] Automatic saroling Loglevel:

12/9/15 1:44 PM /src/data_handler/data_handler.cpp (1506) Error setting tag 4351

12/9/15 1:44 PM /src/data_handler/data_handler.cpp (1502) Tried to set undefined tag 5152
12/9/15 1:44 PM /src/pickup_signal_handler/pickup_signal_handler.cpp (442) select inputs:
12/9/15 1:44 PM /src/pickup_signal_handler/pickup_signal_handler.cpp (442) select inputs:
12/9/15 1:44 PM /src/pickup_signal_handler/pickup_signal_handler.cpp (442) select inputs:
12/9/15 1:44 PM /src/pickup_signal_handler/pickup_signal handler.cpp (442) select inputs:
12/9/15 1:44 PM /src/pickup_signal_handler/pickup_signal_handler.cpp (442) select inputs:

or NP o
[N
ooooo

The window Log serves to support error diagnostics by MOTORTECH.

— Automatic scrolling
If the function is active, the view panel focuses on the latest message.

— Log level
The selection of the log level is specified by MOTORTECH if needed.

—  Write log to file
This checkbox activates or deactivates, respectively, the saving of the logged datain a
selected file. If the function is disabled, the logged data are merely shown on the display.

— Selectfile
With this button, you can select a file to which you want to save the logged data.
If you are prompted to create a log file in the case of a service request, proceed as follows:
1. Open the window Log via the toolbar or the menu bar.
2. Select a path with the Select file button and enter the file name for the log file.

» Ifthe file does not yet exist, it is automatically created with the extension .log.

3. Activate the checkbox Write log to file.
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4. Select the level specified by MOTORTECH from the list Log level.
5. Leave the window open.

» The log messages are logged both in the window and in the selected file.

) Date and time of ignition controller

The date and time can be individually configured for each ignition controller

and saved in the device. The device does not adjust automatically for
daylight savings time. Hence, deviations may occur between the device
time and the time on the computer used to access the device.

NOTICE

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device -> Set date and time.

8.14 Runtime Adjustments
" Click on the symbol to open the window Runtime Adjustments. This window is
only available to users with authorizations starting with access level Service.

& Runtime adjustments are implemented directly

input to be confirmed and are retained even in the case of a MIC4 restart.
Changes that have been saved in the device configuration are only
displayed after re-uploading the device configuration in the MICT's main
window.

. All runtime adjustments are implemented directly without requiring the

NOTICE
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8.14.1 Runtime Adjustments — Reset

( M1 MICT - Runtime Adjustments =
Reset | Timing | Energy | Secondary Voltage Calibration | Secondary Short Calibration |
reset (crane] [JEHE Aov
[&o.5n0v] [ 0.100v] [ o.1rer | [P o.srer |

@ COM3 D MIC4x1.08 (1.5.1 [0000801])

The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device
is being operated. The correction is made with the buttons:

-  0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5ADV/RET
in 0.5° increments to advance or retard
Changes are implemented immediately and stored in the configuration provided in the device.

If the correction range is not sufficient, the reset/index position must be adjusted in the
configuration (refer to Engine — Pickups on page 99).
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8.14.2 Runtime Adjustments — Timing

( M1 MICT - Runtime Adjustments (=[E
[ Reset | Timing | Energy | Secondary Voltage Calibration | Secondary Short Calibration |
Timing Correcton (<cran] [N ReT
Global Tming Paint [~cran<] [ Aov
[o.580v ] [ € 0.100v] [ o.1rer | [P o.srer |

@ COM3 D MIC4x1.08 (1.5.1 [0000801])

The global ignition timing position can be corrected by 50 °crankshaft (advanced/retarded)
while the device is being operated. The correction is made with the buttons:

-  0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5ADV/RET

in 0.5° increments to advance or retard
The limit for the ignition timing set in the schedule (refer to Timing — Schedule A/B — General on
page 105) cannot be exceeded or not reached with the runtime adjustment.

The correction of the global ignition timing is immediately implemented and also remains in
place if the device is restarted. NOTICE: The configuration defined in the device is not changed.
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8.14.3 Runtime Adjustments — Energy

B MICT - Runtime Adjustments ==
Reset | Timing | Energy | Secondary Voltage Calbration | Secondary Short Calibration
Schedule A
Spark Duration [us] -
[&K-100s [ €-1s ] (> +1us | [P +100s]
spark Intensity (ma] [ EEN
[&K-10ma][ €-1ma ] (> +1ma] [P+0om]
Schedule B
Spark Duration [ps] _
€oe) (Cm) (o) (Banm)
spark Intensity (ma] [ EEE
[&K-10ma][ €-1ma ] (D +ima ] [ +10m]
@ COM3 ID MIC4x1.08 (1.5.1 [00002801]))

£ MOTORTECH

The energy settings can be separately adjusted for both schedules. Changes are implemented

immediately and stored in the configuration provided in the device.

Spark Duration
- 4/-1ps

lengthen or shorten in microsecond increments
- +/-10ps

lengthen or shorten in 10 ps increments

Spark Intensity
- +/-1mA

increase and decrease in milliampere increments
- +/-10mA

increase or reduce in 10 mA increments

Rev. 02/2020
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8.14.4 Runtime Adjustments — Secondary Voltage Estimation Calibration

M MICT - Runtime Adjustments =
| Reset | Timing | Energy | Secondary Voltage Calibration | Secondary Short Calibration
All Outputs

[ &-05 |[ €-01 ][ Reset ][ »+01 ][ P+os |

Output Offset -0.5 -0.1 +0.1 +0.5
a1 B« (< (> J[» ]
a2 <« )< )2 JL» )
% <« )< ) )[» )
A4 € C< ) JC» )
s <« < I JC» )
a6 <« )< )2 J[» )
a7 B« )< )2 J[» ]
a8 < (< ]2 [ »]

@ COM3 D MIC4x1.08 (1.5.1 [0000801])

The secondary voltage estimation can be calibrated in this window when using ignition coils that
support this function:

A correction value without units can be set for the secondary voltage estimation for every output
to increase the accuracy of the secondary voltage estimation for each individual cylinder. This
allows, for instance, different cable lengths on the engine to be compensated.

The secondary voltage estimation should be calibrated under full load at a nominal speed. The
adjustment can be made using the relevant global or individual cylinder buttons. The value
range depends on the set ignition coil. 0.0 is set as the standard value for all cylinders.

Changes are implemented immediately and stored in the configuration provided in the device.
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8.14.5 Runtime Adjustments — Secondary Short Calibration
( M1 MICT - Runtime Adjustments (=[E

[ Reset [ Timing | Energy | Secondary Voltage Calbration | Secondary Short Calbration

Secondary Short Enable Voltage

Secondary Short Enable Voltage [kV] D -

Secondary Short Sensitivity

——" B
[ ko1 ][ dkoor | [ dkooor ] [k o.oo01]
[=o01 ][ =001 | [ = 0001 ] = 0.0001]

@ COM3 D MIC4x1.08 (1.5.1 [0000801])

The starting voltage and sensitivity for the secondary short-circuit detection can be adjusted.

MOTORTECH

Changes are implemented immediately and stored in the configuration provided in the device.

Secondary Short Enable Voltage [kV]
Set the necessary average ignition voltage required to activate the secondary short-circuit
monitoring:

— The secondary short detection is always activated at a value of o kV.

— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
- The sensitivity is high at a value of 0.98.

- The sensitivity is low at a value of 1.02.

Rev. 02/2020
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Adjust the sensitivity of the short-circuit monitoring

If a short-circuit is misdiagnosed at a sensitivity of 1.00, the sensitivity
must be set to 1.02.

EXAMPLE If a short-circuit is not detected at a sensitivity of 1.00, the sensitivity must

be set to 0.98.

8.15 Cylinder Individual Offsets

Click on the symbol to open the window Cylinder Individual Offsets. This

window is only available to users with authorizations starting with access level
Service.
( M MICT - Cylinder Individual Offsets =|®
iz S 0.5 I 0.1 0.1 T 0.5
Al llllll ADV [ & J[ < J[ > ][ » ]
A2 lllll RET [ & ] l < ] [ > ][ » ]
A3 lllll RET [ & ll <€ ]l > ][ » ]
A4 IIII. RET [ & l[ < ll > ][ » ]
x5 i o L« JL ¢ JC > JL » ]
a6 I <= L« JL. ¢ JL. > J[. » ]
A7 IIIII RET [ & ][ < ] [ > ][ » ]
A8 lllll RET [ & ll <€ ll > ]l » ]
@ COM3 ID MIC4x1.08 (1.5.1 [00002801])

The cylinder individual offset can be applied to the position of the timing point while the
controller is being operated. Offset via keys:

0.1 ADV/RET
in 0.1° increments to advance or retard

0.5 ADV/RET
in 0.5° increments to advance or retard

The adjustment option of this function is limited by the specified settings in the configuration.
Refer to the section Timing — Schedule A/B — General on page 105.

154

Immediate execution of the changes

Please note that changes made to the timing point are executed
immediately at the next firing of the corresponding cylinder. The maximum
performed change per cycle is however limited by the corresponding setting
in the configuration. For this read Timing — Miscellaneous on page 108.
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Save changes automatically

MOTORTECH

Please remember that changes to the ignition timing are saved

automatically.

8.16 Schedule Curve

Click on the symbol to open the window Schedule.

8.16.1 Schedule Curve — Simulation

M MICT - Schedule

[¥] Simulation
Simulation
Potentiometer
40 60
20 80
/
0

100

(=] & fm
35.0 BTDC
30.0 BTDC
0.00% 2 ]
I ]
25.0 BTDC
= ]
5 V
7 1
= 20.0 BTDC
= o g
15.00mA (5 O
I3
—
.
E 15.0 BTDC N %
=
10.0 BTDC
7.00V % i\
I =
5.0 BTDC
© Schedule B
0.0 ATDC
7 — T — T —
0 500 1.000 1.500 2.000
Speed [RPM]
— MinTiming — MaxTiming — Min Speed Curve Timing — Max Speed Curve Timing — Speed Curve 4 Current speed

Q COM3 1D MIC4x1.08 (1.5.1 [00002801])

The schedule curve visualizes the configurations of the schedules and simulates the influence of
the inputs via the speed range. With the optional input fields, you can switch between schedule
A and B. Changes made by turning the control buttons or entering the desired values are
displayed simultaneously.
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- Simulation
The simulation is activated or disabled using the checkbox.

- Potentiometer
Simulation of the potentiometer

— Control button for adjustments between 0 % and 100 %
— Field for manual input of the desired value in %
— Displays the value in °crankshaft by which the timing is offset
— Analog Current Input
Simulation of the analog current input
- Control button for adjustments between the configured values (e.g. 0 mA and 20 mA)
— Field for manual input of the desired value in mA
— Displays the value in °crankshaft by which the timing is offset
— Analog Voltage Input
Simulation of the analog voltage input
- Control button for adjustments between the configured values (e.g. o Vand 10 V)
— Field for manual input of the desired value in V
- Displays the value in °crankshaft by which the timing is offset
- Schedule A/B
Select between Schedule Aand B
— Timing Point

Displays the global ignition timing as it changes during the simulation.

While connected to the device, the ignition timing is simulated depending on the actual engine
speed and marked as ® in the diagram.
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8.16.2 Schedule Curve — Runtime Values

If the checkbox Simulation is unchecked, the Schedule curve window switches to the current
runtime data.

M MICT - Schedule =)
[F] Siudation 35.0 BTDC
Runtime Values ]
Schedule
Schedule: A i
Potentiometer 30.0 BTDC
e
Analog Current Input :
Analog Voltage Input 1

Lo B
. e 5 .
Speed ézo.o BTDC
I oA
Timing Point o ]
I £1s0mc] |

= ]

10.0 BTDC 4>

5.0 BTDC

0.0 ATDC

——
0 500 1.000 1.500 2.000
Speed [RPM]

— MinTiming — MaxTiming — Min Speed Curve Timing — Max Speed Curve Timing — Speed Curve 4 Current speed

Q COM3 1D MIC4x1.08 (1.5.1 [00002801])

The following information is provided:

— Schedule
Displays the currently selected schedule.

— Left column: Potentiometer, Analog Current Input, Analog Voltage Input
Displays the new calculated adjustment values for the potentiometer, current and voltage
input.

— Right column: Potentiometer, Analog Current Input, Analog Voltage Input
Display of values supplied by the ignition controller for the potentiometer, current and
voltage input.
- Speed
Display of the current speed
— Timing Point
Displays the current global ignition timing.
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8.17 Coils
The MICT has a database with technical information on MOTORTECH ignition coils. Open the

database as follows:

Tools -> Coils

You have the option of storing and printing information on the ignition coils present in the
database. For this purpose, the following functions are at your disposal in the toolbar in the

Coils window.

Symbol Function

Stores the information on the selected ignition coil in a format that is
appropriate for configuring the MIC4 via fieldbus.
Prints the selected coil data set.

Prints the selected coil data set as PDF file.

Opens the print preview.

aaed

Coils
— Device

Select an ignition controller.
- Coil

Select an ignition coil.

& Select the correct ignition controller
The ignition coil data depends on the ignition controller used. Always select
the ignition controller for which you are using the coils in order to obtain

NIGIHICIE the correct data.
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8.17.1 General

= MOTORTECH

M MICT - Coils ==
File
=g =d =
o 5%
Cois [ General | Min. Energy Limit Curve |
Devee: uica ||| -
Coi: |06.50.003 - Name: 06.50.104
06.50.065 Coil Type Id: 6
06.50.100 Data Version: 1
06.50.102
06.50.104
06.50.105
06.50.108
06.50.112 E
06.50.113
06.50.145
06.50.146
06.50.147
0650148 Secondary diagnostics avaiable ifmax. breakdown voltage is setin range 38 kV to 47k Additonaly it s
06‘50‘155 reguired that the energy lmit is set sufficently high according to the min. energy lmit curve.
06.50.156 Coil Parameters
xgiz Parameter Min. Max.
0650162 Max. Breakdown Voltage [kV] 18 47
06.50.300 Spark Intensity [mA] 2 i
06.50.301 Secondary Voltage Estimation Calibration -5 5
93.09.150 Secondary Short Sensitivity 0.98 1.02
Lacnonsn ¢ A%

Details

The following information is provided:

- Name

Coil name
—  Coil Type ID

Used to clearly identify the ignition coil

Data Version

Shows data version of the ignition coil selected in the database. The data version of the
ignition coil configured in the ignition controller is displayed in the runtime data in the view
Ignition (refer to Runtime Data — Ignition on page 124). The Automatic Online Update should
be activated to ensure that the coil database always has the latest data sets. Additional
information on the online update is provided in the section Online Update Settings on

page 79.
Illustration of the ignition coil

Information on the conditions under which a secondary diagnosis is possible using the

displayed ignition coil.
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Coil Parameters
The following information is provided:

Max. Breakdown Voltage [kV]

Displays the permitted value range for the maximum breakdown voltage in kV. The
maximum breakdown voltage is configured in the view Ignition Timing — Schedule A/B -
Energy (refer to Timing — Schedule A/B — Energy on page 107).

Spark Intensity [mA]

Displays the permitted value range for the spark intensity in mA. The spark intensity is
configured in the view Ignition Timing — Schedule A/B — Energy (refer to Timing — Schedule
A/B - Energy on page 107).

Secondary Voltage Estimation Calibration

Displays the permitted value range for the secondary voltage estimation calibration. The

calibration of the secondary voltage estimation takes place in the view Engine — Ignition

Coils (refer to Engine — Ignition Coils on page 97) and in the runtime adjustments (refer to
Runtime Adjustments — Secondary Voltage Estimation Calibration on page 152).

Secondary Short Sensitivity

Displays the permitted value range for the calibration of the secondary short sensitivity. The
calibration of the secondary short sensitivity takes place in the view Engine — Ignition Coils
(refer to Engine — Ignition Coils on page 97) and in the runtime adjustments (refer to Runtime
Adjustments — Secondary Short Calibration on page 153).
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8.17.2 Min. Energy Limit Curve
(8 MICT - Coils B

File
o 5545
>
Coils. General Min. Energy Limit Curve
Device: [MIC4 ~)

Min. Energy Limit Curve
Coi: |06.50.003 - 300
06.50.065 I ]
06.50.100
06.50.102
06.50.104
06.50.105
06.50.108
06.50.112
06.50.113
06.50.145
06.50.146
06.50.147
06.50.148
06.50.155 L
06.50.156
06.50.157 ]
06.50.158 0 r T T T T T T 1
06.50.162 15 20 25 30 35 40 45 50
06.50.300 Max. Breakdown Voltage [kV]
ggixﬁi;l) | — Min. Energy Limit == Min./Max. Limit Secondary Diagnostics

Acnonin &

N
a
1=}

~
=3
S

i

—
7]
=)

B o

oy
o
S

Min. Energy Limit [mJ]

Min. Energy Limit Curve

The curve provides information on the energy in m) necessary to achieve a certain maximum
breakdown voltage in kV. The two vertical bars show the breakdown voltage area, in kV, in which
a secondary diagnosis is possible. The corresponding energy settings can be found in the view
Timing — Schedule A/B - Energy (refer to Timing — Schedule A/B — Energy on page 107).

When printing the coil data set, the curve values are also provided as a list.
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9.1 Start-up

Before you start up the MIC4 ignition controller, take note of the following:

Were the correct engine, ignition sequence, and output configuration selected? If you are
unsure, contact MOTORTECH or the corresponding engine manufacturer.

Ensure that the firing order of the engine and/or the wiring of the output cable harness are
carried out correctly.

Is the wiring of all pickups compliant with the drawings given in this operating manual?

Are the distances of the pickups to trigger discs, reluctor pins, etc. correctly set (see chapter
Determine the Installation Location of the Pickup on page 36)?

Ensure that the data were transferred flawlessly to the controller.

Check whether the start/stop input is set to Firing Active, or whether it works according to
the control requirements of the master control.

Check whether the input contact for parameter settings A/B (Schedule A/B) functions and
ensure that the correct schedule (A or B) was selected for start-up.

Close the service screw and the service cover after completing the installation and
configuration.

Ensure that no gas is present in the inlet and exhaust systems before you start the engine.
Ensure that the gas valve is closed.
Perform the normal engine start-up process while the gas valve is closed (start only).

Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing
point set on the ignition controller coincides with the actual timing point on the crankshaft.
If the ignition timing does not coincide exactly, change it (see chapter Runtime Data on
page 118) until the optimal setting is reached. If the ignition does not fire, read the
instructions in section Troubleshooting on page 169.

Check all other cylinders for correct ignition. If they are not correct, stop the engine, and
recheck wiring and ignition sequence for correctness.

Stop the starting process. If no problems occur, start the engine in accordance with the
specifications of the engine manufacturer.

9.2 Shutdown
The ignition controller is shut down by disconnecting it from the power supply.
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9.3 Firmware Update
Using the MOTORTECH Flash Tool, you can update the firmware of the ignition controller. The
program is provided on the storage device (USB flash drive or CD-ROM supplied).

Install MOTORTECH Flash Tool
Install the MOTORTECH Flash Tool as follows:

1. Start the installation:

- Viathe menu:
Start the file Start.exe on the storage device. Start the installation routine for the
MOTORTECH Flash Tool via Software -» MOTORTECH Flash Tool -> Install MOTORTECH
Flash Tool.

- Directly from the storage device:
Start the installation routine of the MOTORTECH Flash Tool directly. It is on the storage
device in the subdirectory Installation and for example named as follows:
MOTORTECH-Flash-Tool-0.9.00003-setup.exe.

2. Install the program.
Follow the instructions of the installation routine. Note that the license agreement terms
must be accepted before using the MOTORTECH Flash Tool.

3. |Ifthe USB driver is not yet installed, also install it via the menu or directly from the storage
device.

— Viathe menu:
Software -> USB Drivers -» Install USB Drivers

- Directly from the storage device:
Start the exe file in subdirectory Drivers
(e.g. CDM v2.10.00 WHQL Certified.exe).

» The MOTORTECH Flash Tool is set up. You can now connect your computer to the ignition
controller via the USB interface.
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Menu Bar and Toolbar
After launching the MOTORTECH Flash Tool, the following functions are available to you via the
icons on the toolbar and the entries in the menu bar:

Symbol

£ & W

Menu

File -> Open

File -> Quit

View -» Extended file information
view

View -» Extended connection
settings

View -5 Reload file

Device -»> Search devices

Device -» Flash device

Settings -> Language

Help -> Help

Help -> About MOTORTECH Flash
Tool

Start Firmware Update

164

Function

Opens a firmware file.

Exits the program.

Fades in / out additional information of the
firmware file.

Fades in / out additional information and
settings of the connection to the device.

Reloads the file information of the selected
firmware file.

Restarts the search for connected devices.

Starts the update process or downgrade
process.

Opens the window Select Language in
which you can change the interface
language of the program.

Opens the online help function.

Opens detailed information on the
program.

Access control for firmware update

If you have activated the access control for the ignition controller, you need
the PIN for the level Master for the firmware update. For more information
read the section Access Control for MIC4 on page 84.
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& Backup the existing configuration
Your device's configuration may be lost if the firmware update is not
performed properly. Always backup the existing configuration via the MICT

prior to performing an update. For more information read the section

B Lt Working with Configurations on page 86.

To start a firmware update, proceed as follows:
1. Ifan MICT is connected with the ignition controller, disconnect this connection.

2. Startthe MOTORTECH Flash Tool via Start -> Programs ->» MOTORTECH -» MOTORTECH Flash
Tool -> x.x.x (e.g. 0.9.00003) ->» MOTORTECH Flash Tool.

» The MOTORTECH Flash Tool will now start.

» The software automatically checks all ports for connected devices.

3. Inthe Status section under Device, check if your device has been recognized properly.

> Ifthe MOTORTECH Flash Tool does not recognize a device that is connected to your PC
via the USB interface, you can usually still carry out a firmware update. To do so,
observe the instructions in the information windows of the MOTORTECH Flash Tool for
the following steps.
4. Selectin area File using the Select button the desired update file.

5. Byreading the displayed file information, ensure that the update file is correct for your
device.

6. Start the update process using the Flash button or using the menu or toolbar.
> The ignition controller is restarted automatically.
> Now, a window opens informing you about the firmware version currently used on your
ignition controller and also about the relevant update version.
7. Confirm with Yes to proceed with the update process.
> Now the update will start.

> Ifthe firmware update was successful, you will see a relevant message.

8. After a successful firmware update, check all configuration data.

& Downgrade process
The process for a downgrade is largely the same as the update process. You
will only be informed that a new firmware has been installed on the device.

NOTICE
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Help with connection problems

If a correctly connected device is not found during the automatic search,
this can, for example, be because too many communication interfaces are
assigned and must be checked. In this case, an interface from the
drop-down list Port in the area Connection can be selected and thus
specified.

If the desired port is not yet displayed in the list or if the problem should
continue, an adjustment of the time-outs for the connection helps. The
time-out settings are displayed in the main view by the following entry in
the menu bar: View -» Extended connection settings

Enter the following settings:

— Update Request Timeout
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms.
An extension of the time-out can be an advantage, especially with
connection problems that occur because the computer has many
assigned ports.

— Time-out for the Start
adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms. A
time-out change can be an advantage, especially with connection
problems that occur because the communication between the computer
and the device has been interrupted.
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10.1 Possible Faults
The MIC4 ignition controllers include several safety functions that can shut down the engine in
case of fault:

— Overspeed protection

- External shut-down contact (Start/Stop)

- Misfire detection (primary)

— Internal failure of the high voltage supply

— Output Error Detection

— Shut down in the case of a faulty pickup or faulty pickup signals.
- Alarms

- Faulty voltage supply

- External EMI signals

10.2 Causes of Faults

10.2.1 Overspeed
The engine speed has exceeded the set overspeed value.

Potential Causes
- Speed controller does not function properly

—  Fuel supply to engine is not optimal.

-  Faulty pickup signal

10.2.2 Output Error Detection
An internal failure of the high voltage supply or a defective output switch occurs.

Potential Causes
- Hardware fault on the MIC4

— Defect in the wiring (short circuit or open circuit)

10.2.3 Misfire Detection (Primary)
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime
data.

Potential Causes
— Defect in the output wiring

— Ignition coil defective
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10.2.4 Pickup Input Errors
Faulty input signals from the pickups are detected.

Potential Causes
- Number of teeth on the flywheel does not match the set number.

— Damage to or uneven running of trigger disc
- Interference in the wiring of the pickup

—  Wiring of the pickup incorrect

- Distance of the pickup incorrect

— Dirt on the pickup

Troubleshooting for Possible Causes

You will find information on possible causes of a pickup input error in the windows Runtime Data
— States (see Runtime Data — States on page 127) and Runtime Data — Message Log (see Runtime
Data — Message Log on page 133). When analyzing the messages shown there, please note that
the number of the pickup (e.g. PU2) only names the pickup at which the error or problem was
identified. Hence, this does not mean that this particular pickup also caused the problem. For
example, if the pickup PU1 is defect, it is entirely possible that, under certain circumstances, the
problem may only be identified at pickup input PU2.

For information on the numbers shown in the error messages (e.g. PU1=0x00001002), refer to
the documentation on the pickup status bits on the storage device enclosed with the ignition
controller. You can open the file via the menu: Documentation -> More information.

For a more in-depth analysis of the problem, the pickup traces may support you. Refer to the
section Pickup Trace on page 82. Compare the signals recorded there with the pickup settings in
your configuration (see Engine — Pickups on page 99).

10.2.5 Acknowledging Faults
While the engine is shut down, you have the following options for acknowledging operating
errors:

- Use Error Acknowledge in the MICT
— Acknowledgment of the error via CAN bus or RS485
— Bydisconnecting the supply voltage

— Hold button PB on the controller longer than three seconds
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10.3 Troubleshooting

10.3.1 Running a Self Test

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs. For this read section Self Test on
page 8o.

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber.
Non-compliance can result in damage to equipment or injury to persons.

10.3.2 Customer Service Information
You can reach our customer service during business hours at the following phone and fax
number, or by email:

Phone: 449514193990

Fax: +49 514193 99 99
Email: service@motortech.de

10.3.3 Returning Equipment for Repair/Inspection
To return the device for repair and inspection, obtain a return form and return number from
MOTORTECH.

Fill out the return form completely. The completely filled out return form guarantees fast,
uncomplicated processing of your repair order.

Send the device and the return form to one of the two addresses below or to the nearest
MOTORTECH representative:

MOTORTECH GmbH MOTORTECH Americas, LLC
Hogrevestr. 21-23 1400 Dealers Avenue, Suite A
29223 Celle New Orleans, LA 70123
Germany USA

Phone: +49514193990 Phone: +1504 3554212

Fax: +495141939998 Fax: +1504 3554217
www.motortech.de www.motortechamericas.com
motortech@motortech.de info@motortechamericas.com
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10.3.4 Instructions for Packaging the Equipment
For return shipment, equipment should be packaged as follows:

170

Use packaging material that does not damage the equipment surfaces.

Wrap the equipment with sturdy materials and stabilize it inside the packaging.

Use sturdy adhesive film to seal the packaging.
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11.1 Maintenance Instructions
Please follow the following maintenance instructions:

- Do not use caustic liquids or steam cleaners for cleaning the device.
— Clean the passive pickups at regular intervals.
— Check the ignition wires at regular intervals.

— Replace the pickups at regular intervals if operating them under elevated temperature
conditions (> +90 °C / > +194 °F).

- Regularly inspect all wires of the ignition system for damage and replace the wires as
needed.

- Check all plug-in connections for proper condition.
- Service the spark plugs as per the instructions of the spark plug and engine manufacturers.
— Observe the required tightening torques:

- All Mg bolts: 0.8 Nm to 1 Nm (0.6 lb-ft to 0.7 lb-ft)

- PG screw joints: 4.5 Nm to 5 Nm (3.3 lb-ft to 3.6 lb-ft)

- Service screw: 2.5 Nm to 3 Nm (1.9 lb-ft to 2.2 b-ft)

11.2 Spare Parts and Accessories
For spare parts and accessories for MIC4 ignition systems, please refer to our current product
guide, which is available for download on the Internet at www.motortech.de.
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